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Document number/revision: 10092796P1-07 REV D (October 2015).

The information in this document is subject to change without notice. United Technologies
Corporation (“UTC”) assumes no responsibility for inaccuracies or omissions and specifically
disclaims any liabilities, losses, or risks, personal or otherwise, incurred as a consequence,
directly or indirectly, of the use or application of any of the contents of this document. For the latest
documentation, contact Supra or visit us online at www.keyadvantage.com.

This publication may contain examples of screen captures and reports used in daily operations.
Examples may include fictitious names of individuals and companies. Any similarity to names and
address of actual businesses or persons is entirely coincidental.

Supra is a registered trademark of United Technologies Corporation.

Other trade names used in this document may be trademarks or registered trademarks of the
manufacturers or vendors of the respective products.

Important: This end-user license agreement (“Agreement”) is a legal agreement between

UTC Fire & Security and You. Read the following terms and conditions carefully before installing
or using this Software. This agreement provides a license from UTC Fire & Security to use the
Software. It also contains warranty information, disclaimers, and liability limitations. Installing and/
or using the Software confirms Your agreement to be bound by these terms and conditions. If
You do not agree with these terms and conditions, do not install or use the Software or, if already
installed, immediately cease all use of the Software and promptly uninstall all components of the
Software.

1. Definitions. The following definitions apply to this document:

a. “UTC Fire & Security”, with respect to title to or warranty of the Software, means
UTC Fire & Security Americas Corporation, Inc., a Connecticut corporation.

b. “Software” means the executable software or firmware programs and accompanying
documentation installed on the UTC Fire & Security products, plus any upgrades, modified
versions, updates, additions, and copies of the software furnished to Customer during the
term of the license granted herein.

Cc. “Documentation” means all associated media, printed materials, and electronic
documentation accompanying the Software.

“Licensed Product” means the Software and Documentation.

“Customer” means the person or organization, or parent or subsidiary thereof, who uses
the Software for its intended purposes, and excludes distributors, authorized resellers,
value-added resellers and original equipment manufacturers. Customer may be referred to
as You or Your, whether an individual or a business entity of any kinds.

f.  “Machine” means the computer, workstation, terminal, or other hardware product on which
the Software is installed.

2. License. All rights to and in the Licensed Product, including, but not limited to, copyrights,
patents, trademarks, and trade secrets, belong to UTC Fire & Security, and UTC Fire & Security
retains title to each copy of the Software. You agree that UTC Fire & Security at any time,

upon reasonable notice, may audit Your use of the Software for compliance with the terms

and conditions of this Agreement. Subject to the terms and conditions of this Agreement,

UTC Fire & Security grants You a nonexclusive license to use the Software, but only in the country
where acquired, provided that You agree to the following:

You may:
a. install and use the Software on a single Machine at one time, unless You have purchased

additional copies of the Software, in which case You may install the software on the
number of Machines for which You have purchased copies of the Software;

b. use the original copy of the Software provided to You for backup purposes.
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You may not:

a. transfer or distribute the Licensed Product to others, in electronic format or otherwise, and
this Agreement shall automatically terminate in the event of such a transfer or distribution;

b. use the Software over a computer network;
c. sell, rent, lease, or sublicense the Software;
d. copy or modify the Licensed Product for any purpose, including for backup purposes.

3. Term. This Agreement is effective until terminated. You may terminate this Agreement by
uninstalling all components of the Software from all Machines and returning the Software to

UTC Fire & Security. UTC Fire & Security may terminate this Agreement if You breach any of these
terms and conditions. Upon termination of this Agreement for any reason, You agree to uninstall all
components of the Software and return the Licensed Product to UTC Fire & Security. All provisions
of this Agreement relating to (i) disclaimer of warranties; (ii) limitations on liability, remedies,

and damages; and (iii) UTC Fire & Security’s proprietary rights, shall survive termination of this
Agreement.

4. Object code. The Software is delivered in object code only. You may not alter, merge, modify,
adapt, or translate the Software, nor decompile, disassemble, reverse-engineer, or otherwise
reduce the Software to a human-perceivable form, nor create derivative works or programs based
on the Software.

5. Limited warranty. UTC Fire & Security warrants that for one (1) year from the date of delivery of
the Licensed Product (Software Warranty Period), the functions contained in the Software will be fit
for their intended purpose as described in the applicable Documentation from UTC Fire & Security,
and will conform in all material respects to the specifications stated in such Documentation.

UTC Fire & Security does not warrant that the operation of the Software will be uninterrupted or
error-free. UTC Fire & Security does warrant that the media on which the Software is furnished

will be free from defects in materials and workmanship under normal use for a period of thirty

(30) days from the date of delivery (Media Warranty Period). Except as specifically provided
therein, any other software and any hardware furnished with or accompanying the Software is not
warranted by UTC Fire & Security.

Your exclusive remedy under this limited warranty for nonconforming Software shall be repair or
replacement of the Software, at the sole discretion of UTC Fire & Security. To obtain a repair or
replacement of nonconforming Software, contact UTC Fire & Security Customer Service toll-free at
1-866-259-8077 or online at www.keyadvantage.com during the Software warranty period.

Except as expressly provided above, the licensed product is provided “as is” without warranty
of any kind, either expressed or implied, including, but not limited to, implied warranties of
merchantability or fithess for a particular purpose and, except as expressly provided above, You
assume the entire risk as to the quality and performance of the licensed product.

6. Limitation of liability. UTC Fire & Security’s sole obligation or liability under this agreement

is the repair or replacement of honconforming software and/or defective media according to

the limited warranty above. In no event will UTC Fire & Security be liable for damages, whether
consequential, incidental, or indirect, nor for loss of data, loss of profits, or lost savings, arising
from use or inability to use the software or documentation (or any hardware furnished with the
software), even if UTC Fire & Security has been advised of the possibility of such damages, nor for
any claim by any third party.

7. General. Any materials provided to You by UTC Fire & Security shall not be exported or
reexported in violation of any export provisions of the USA or any other applicable jurisdiction. Any
attempt to sublicense, assign, or transfer any of the rights, duties, or obligations hereunder shall
be void. This Agreement shall be governed by and interpreted under the laws of the State of New
York, United States of America, without regard to conflicts of law provisions. You hereby consent
to the exclusive jurisdiction of the state and federal courts located in Multnomah County, Oregon,
to resolve any disputes arising under or in connection with this Agreement, with venue in Portland,
Oregon.
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Intended use

FCC Compliance

EMC Directive

X

Regulatory

8. Restricted rights legend. The Licensed Product is provided with RESTRICTED RIGHTS.

In the event the United States Government or an agency thereof is granted a license, the
following additional terms apply: Restricted Computer Software, as defined in the Commercial
Computer Software—Restricted Rights clause at Federal Acquisition Regulations 52.227-19, and
the restrictions as provided in subparagraphs (c)(1) and (c)(2) thereof; and as applicable, the
Government’s rights to use, modify, reproduce, release, perform, display, or disclose the Software
also are restricted as provided by paragraphs (b)(2) and (b)(3) of the Rights in Noncommercial
Technical Data and Computer Software—Small Business Innovative Research (SBIR) Program
clause at DFARS 252.227-7018.

9. Acknowledgment. You acknowledge that You have read and understand this agreement

and agree to be bound by its terms. You further agree that this agreement is the complete and
exclusive statement of the agreement between You and UTC Fire & Security, and supersedes any
proposal or prior agreement, oral or written, and any other communication relating to the subject
matter of this agreement.

Use this product only for the purpose it was designed for. For the latest product information,
contact Supra or visit us online at www.keyadvantage.com.

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a residential environment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful interference to radio
communications.

Changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate the equipment.

The European Union directive on electromagnetic compatibility (2004/108/EC) requires non-
European manufacturers to designate an authorized representative in the Community.

Our European representative is UTC Fire & Security B.V., Kelvinstraat 7, 6003 DH Weert,
Nederland.

The European directive Waste Electrical and Electronic Equipment (WEEE) aims to minimize

the impact of electrical and electronic equipment waste on the environment and human health.
For proper treatment, recovery, and recycling, return the equipment marked with this symbol to
your local supplier upon the purchase of equivalent new equipment, or dispose of it in designated
collection points.

1SO 9001
c € Certified
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Preface

Preface
This manual includes an overview of KeyAdvantage products, and detailed instructions explaining:
* how to log on to KeyAdvantage;
* how to create and assign users, key holders, and key holder groups; and
* how to use KeyPads, KeyBoxes, and KeyAdvantage data.
There is also information describing how to contact technical support if you have questions or concerns.
To use this document effectively, you should have the following minimum qualifications:
* abasic knowledge of the MS Windows operating system; and
* abasic knowledge of vehicle information data tracking.

Read these instructions and all other documentation entirely before installing or operating this product. The most
current versions of this and related documentation may be found on our website.

The following conventions are used in this document:

Bold Menu items and buttons.

Italic Emphasis of an instruction or point; special terms.

File names, path names, windows, panes, tabs, fields, variables, and other GUI elements.

Titles of books and various documents.

Blue italic (Electronic version.) Hyperlinks to cross-references, related topics, and URL addresses.

Monospace Text that displays on the computer screen.

Programming or coding sequences

Safety terms and symbols

These terms may appear in this manual:

CAUTION: Cautions identify conditions or practices that may result in damage to the equipment or other
property.

WARNING: Warnings identify conditions or practices that could result in equipment damage or serious
personal injury.

1
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Chapter 1. Introduction

The KeyAdvantage System is an electronic KeyBox system designed to give
auto dealerships better control over access to vehicle keys.

The KeyAdvantage system consists of:
e Electronic KeyPads, which are checked out by key holders.

* Electronic KeyBoxes, which are assigned to dealerships and
departments.

e Electronic KeyTags, which are assigned to specific vehicles.
* KeyAdvantage software, used to track activity, assign inventory, and

(Supra KeyAdvantage

create user permissions. L o

* Aprogramming base, which connects KeyAdvantage inventory to the
KeyAdvantage software.

They KeyAdvantage system can be configured one of two ways:

» Assign KeyPads to specific key holders: KeyPads are assigned to
specific key holders in the KeyAdvantage software. Key holders can
only check out KeyPads that are assigned to them. Any number of
KeyPads can be assigned to a key holder, but a KeyPad can only be
assigned to one key holder at a time.

* Allow key holders to check out any KeyPad: Key holders can check
out any KeyPad that is not already checked out. The key holder’s
information is stored in the KeyPad only for the duration of the key
holder’s shift. You can limit the number of KeyPads a key holder is
allowed to check out.

KeyAdvantage Overview

At the beginning of their shift, each salesperson checks out a KeyPad at the
KeyAdvantage computer. Checking out a KeyPad activates it and programs
the key holder’s PIN code and permissions into the KeyPad. In order to check
out a KeyPad, the key holder must be set as Active in the KeyAdvantage
software and within the set access hours.

If your system is configured to require purpose codes, key holders are required
to choose a description of why they are accessing the vehicles keys when they
access a KeyBox. Reports can be generated showing who accessed vehicle
keys and for what purpose.

Key holders access KeyBoxes by entering their PIN, selecting a purpose code,
and touching the KeyPad to the KeyBox. They can then open the KeyBox and
remove the vehicle keys. Both the KeyPad and KeyBox record who accessed
the vehicle keys, and the date and time of the access.

Before leaving the vehicle, the key holder returns the vehicle keys to the
KeyBox and closes it. The KeyPad can also be used to read the KeyBox and
instantly display who last took the vehicle key.

The key holder carries the KeyPad throughout his shift. At the end of the
shift, the key holder checks in the KeyPad, and the activity for that day is
downloaded into the KeyAdvantage software.

2
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KeyAdvantage System Controls

The KeyAdvantage system has a number of integrated security features. Some system controls, such as tracking
parameters, are built into the system and are not optional. Others, such as purpose codes, can be configured
based on your company’s security needs.

Software Controls
The KeyAdvantage system utilizes user permissions to control access to the software.

There are two types of system users: those who only need access to the KeyAdvantage software in order to
check in and out their KeyPad, and those who need access to the software in order to administer the system.

The KeyAdvantage system has built-in classifications for a wide range of user permissions, based on the
requirements of each person:

» Key holders can be set up with varying degrees of KeyBox access based on which dealerships and
departments that they need to access.

* There are five preset administrative profiles. See “Preface” on page 23 for more detailed information
about user profiles and permissions.

The status of any KeyAdvantage user can be changed to disallow them from using the system. Only users with
a status of Active can check out KeyPads or log into the KeyAdvantage software. Users with an Inactive status
cannot access the system.

KeyPad Controls

KeyAdvantage KeyPad controls include the use of PIN codes, KeyPad expiration, KeyBox access limits, bad PIN
code lockout, KeyBox access tracking, audit trails, and purpose codes.

PIN Code

The most basic security feature of the KeyPad is the PIN code. Accessing the vehicle keys requires the valid PIN
code for the user assigned to the KeyPad be entered.

* If a KeyPad is lost or stolen, the KeyPad cannot access vehicle keys without the use of the PIN code.

« If five consecutive incorrect PIN codes are entered into the KeyPad, the KeyPad shuts down for 10
minutes.

* The PIN code is a 4-digit number. There are 10,000 possible combinations of four digits.

KeyPad Expiration

» KeyPads can only be used to access KeyBoxes when checked out by
a key holder. The KeyPad then expires at the end of the key holder’s
shift.

» If a KeyPad is not updated or is not checked out, it displays KEY
EXPIRED CHECK OUT KEY when itis powered on. The user must
check out the KeyPad using the programming base or manually update
the KeyPad to use it to access KeyBoxes.

KeyBox Access Limit

* The system administrator can limit the number of KeyBoxes a user’s Gopen Mg T\
KeyPad can access during the key holder’s shift by defining the
maximum number when creating the key holder record.
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Bad Code Lockout

* The KeyPad keeps track of all incorrect codes entered into the KeyPad. This includes incorrect PIN codes
and incorrect update codes. If five consecutive incorrect codes are entered, the KeyPad times out and
locks up for 10 minutes except to connect to the programming base or to view recent error codes.

« If the KeyPad has timed out due to numerous incorrect codes, when the KeyPad is powered on it sounds
the problem tone and displays SECURITY LOCKOUT KEY DISABLED.

See “Audio Feedback” on page 9 for more information on the tones used by the KeyPad, and each tone’s
meaning.

KeyBox Access Tracking
* The KeyPad holds tracking information for a maximum of 500 KeyBox accesses.

*  When a KeyPad reaches the maximum number of vehicle accesses, the KeyPad does not allow access
to another KeyBox until the access information in the KeyPad is transmitted to KeyAdvantage software.

»  Checking in the KeyPad clears the tracking information.

Audit Trail

* The KeyPad keeps an audit trail of all KeyBoxes and KeyTags it has accessed and, if purpose codes are
required, why it accessed them.

* The vehicle access audit trail includes the ID and name of the key holder, the KeyBox and KeyTag
accessed, the date and time of access, and the purpose code for the access.

« Each time the KeyPad is checked in, its access information is automatically downloaded to the
KeyAdvantage system software and can be viewed through reports and other software screens. If a
KeyPad is not checked in at the end of the key holder’s shift, it is automatically checked in the next time it
is checked out.

Purpose Codes

* Adealership may require that a key holder specify the purpose of accessing the vehicle keys each time
the KeyBox is opened. If purpose codes are required, a key holder cannot obtain the vehicle keys until
they have selected a purpose code on the KeyPad.

* The Night Removal purpose code also allows a KeyPad to open multiple KeyBoxes without having
to enter a PIN code each time. This is useful for dealerships that remove the vehicle keys from the
KeyBoxes each night.

»  After the user enters their PIN code to access a KeyBox, if the system requires a purpose code, the first
purpose code is displayed. The up and down arrow buttons (8¢ 2t) are used to scroll through the list. The
user must press Enter when the desired purpose code is displayed. Scrolling through purpose codes is
bidirectional and wraps around.

* The KeyPad can contain up to 10 unique purpose codes. The first seven purpose codes are preset by
Supra. The remaining three purpose codes are customer configurable.

* The first 7 purpose codes are:

0—Sales Demo 4—Body Shop
1—Service 5—Aftermarket
2—PDI 6—Overnight

3—Night Removal

* Reports can be generated to show why vehicles were accessed.

4
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KeyBox Controls

The KeyAdvantage KeyBox controls include the use of lockout lists, bad code lockout, audit trails, and nightly key
removal.

Lockout List
» If an active KeyPad is lost or stolen, a KeyBox can be programmed to lock out a KeyPad.

*  The KeyBox must connect to the KeyAdvantage software through the programming base to have a
KeyPad added to its lockout list.

*  The lockout list can contain up to 5 KeyPad serial numbers.
* The lockout list can be viewed by diagnosing the KeyBox on the programming base.

* The KeyPads on the lockout list cannot open the key container on the KeyBox but they can read the
KeyBox.

Bad Code Lockout

» The KeyBox tracks invalid entry attempts. If the KeyBox encounters 10 consecutive incorrect access
attempts, the KeyBox times out and locks up for 10 minutes.

Audit Trail

* The KeyBox keeps an audit trail of KeyPads that have accessed it, and if purpose codes are required,
why it was accessed.

* The KeyBox access audit trail includes the name of the key holder, the KeyTag accessed, the date and
time of access, and the purpose code for the access.

* The KeyBox stores the most recent 35 access records. The information can be viewed either by reading
the KeyBox with a KeyPad or connecting the KeyBox to the system software using the programming
base.

Nightly Key Removal

* Nightly key removal is an optional feature for dealerships who wish to take the vehicle keys out of
KeyBoxes at the end of the day.

*  When the Night Removal purpose code is selected, the KeyPad allows the user to access multiple
KeyBoxes without reentering the PIN code.

»  After a successful KeyBox access operation, the KeyPad prompts the user again to point the KeyPad
towards a KeyBox to begin communication. The next KeyBox access must occur within 2 minutes or the
KeyPad displays NO BOX FOUND and powers down.

»  After the KeyPads used for nightly key removal are checked in, a Vehicle Key Removal Reconciliation
report can be run to see if there are any vehicle keys outstanding.
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The KeyPad

The KeyAdvantage KeyPad is an electronic key that is used to access the KeyAdvantage KeyBox. A KeyPad

is programmed daily when a user places it on the KeyAdvantage programming base to check it out. During
checkout, the KeyPad is programmed with the permissions and access hours assigned to the user in the
KeyAdvantage software. These permissions determine which KeyBoxes the KeyPad can open, when KeyBoxes
can be opened, and how many can be opened during their shift.

When the KeyPad accesses a KeyBox, the KeyPad records:

Who took the vehicle keys.

Which KeyBox was opened.

Which vehicle keys were taken.

When the vehicle keys were taken.

Why the vehicle keys were taken.

How long a KeyTag was out of the KeyBox.

Physical Characteristics

The KeyPad has an infrared interface on the top of the KeyPad which is used to communicate with the
KeyBox and programming base.

The KeyPad has a backlight to easily view the display in outside, evening lighting conditions.

The KeyPad has audible and visual feedback for errors, low batteries, button presses, and function
completion.

The KeyPad uses (2) AAA alkaline batteries as its main power source. When the batteries are low, the
KeyPad emits two short buzzes and displays a low battery warning message. If the batteries in the
KeyPad are removed and replaced, an internal lithium battery operates as a backup so that the KeyPad’s
memory and functionality are not impacted.

6
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KeyPad User Interface
The KeyPad features 16 buttons:
* 10 buttons numbered 0-9 used to enter codes
*  Green start button
*  Three blue menu buttons
* Blue enter button
»  Blue backspace/backlight button
* Up & Down scroll buttons, numbered buttons 2 and 8, are used in some menus

Start

Up/Down
Keyt?‘”‘ Scroll
Information Arrows
KeyPad
Information
Backspace/
Update Backlight

Enter

KeyPad Navigation
= Green Start button
*  Powers on the KeyPad
* Resets the KeyPad

Press a blue menu button when the KeyPad is powered on to launch the menu options. Press a blue menu
button repeatedly to cycle through the KeyPad menu options:

KeyBox Information
— Read KeyBox
— View last KeyBox read

juio

KeyPad Information

— View user info

— Review error codes

— Display KeyPad battery status

O Update

— Used to enter a manual update code when the KeyPad cannot be checked out using the
KeyAdvantage programming base
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* Press to backspace (erase) an incorrect number entered.

* Press and hold for 1 second to toggle the backlight on or off while the KeyPad is powered on. The
backlight turns off when the KeyPad times out and powers down.

8¢ 2+ Up/Down Scroll Buttons

*  The scroll Up/Down buttons may be used to view additional information in the Read KeyBox, View Last
Read Box, Error Codes, User Information menus and purpose codes.

Audio Feedback

Audio tones are used by the KeyPad to indicate the status of an operation. They indicate when an operation has
been performed successfully, and help determine the cause of an unsuccessful operation. There are nine audio

tones generated by the KeyPad:

Tone Explanation

1 short beep

A button on KeyPad has been pressed

2 short beeps

A successful keystroke sequence has been entered

4 short beeps

Operation complete

1 buzz

Wrong number of digits or wrong code entered, or
operation is not allowed

2 short beeps repeated

KeyPad is searching for KeyBox

1 short beep repeated

KeyPad is communicating with KeyBox

Silence

Communication between KeyPad and KeyBox
interrupted

2 short buzzes

KeyPad batteries are low

3 short buzzes

KeyPad has been disabled

Visual Feedback

If an error occurs, a problem tone is sounded and an error message is displayed. See
Appendix A: Troubleshooting on page 67 for more information on error codes.

User Operations

KeyPad user operations include powering the KeyPad on and off, reading KeyBoxes, viewing KeyPad
information, performing manual updates, viewing error codes, and checking the KeyPad battery status.

Powering On [

The KeyPad is powered on by pressing the green Start button. When the KeyPad is first powered on, it displays
the name of the person the KeyPad is currently assigned to, then automatically goes to the Obtain Key menu.

Powering Down

The KeyPad does not have a button to turn it off, but it does power itself down automatically. There are several
instances where the KeyPad powers down to maximize battery life: after a function is completed, the KeyPad

powers down; if a button is not pressed for 20 seconds, the KeyPad powers down; when connecting to a KeyBox,

the KeyPad searches for a KeyBox for 2 minutes and then powers down.

8
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Read KeyBox & View Last KeyBox Read

When the KeyPad reads a KeyBox, the 5 most recent accesses can be viewed on the KeyPad. The KeyPad
displays the key holder name and KeyPad serial number. Press the Enter button to view the date and time of
the access selected. To view the next access record, press the Down Arrow (8+) button to scroll through the
additional entries.

« Acomplete KeyBox read (which consists of the most recent 35 entries) can be downloaded to the
KeyAdvantage software by checking in the KeyPad that performed the KeyBox read. The information can
then be viewed as an Access report.

* The KeyPad can store one KeyBox read at a time. Use the View Last KeyBox Read menu option to view
KeyBox access details from the KeyBox read.

See “Reading KeyBoxes” on page 54 for details on reading KeyBoxes.

KeyPad Information [ §

When a KeyPad is powered on, it displays the name of the user to whom it is currently assigned. If the KeyPad is
unassigned it shows that it is unassigned and invalid.

* The KeyPad assumes the identity of the user when the user checks out a KeyPad. This information is
programmed into the KeyPad when it connects to the KeyAdvantage software through the programming
base.

« The KeyPad functions according to the key holder’s permissions when the user checks out a KeyPad.

The User Information menu option also shows the name of the assigned user. While the user name is displayed
in this menu, pressing the Down Arrow (8+) button will show the date and time that the KeyPad is valid. The time
displayed on the KeyPad will always be Standard Time. If Daylight Savings Time is in effect, only the time shown
on reports will reflect Daylight Savings Time; a “D” will be displayed next to the time on the KeyPad.

To display the user information:

1. Press the Start (€=) button to turn on the KeyPad.

2. Press the KeyPad Information (§) button repeatedly until the User Information menu is displayed.
3. Press the Enter button.
4

Press the Down Arrow (8+) button to view the date and time of the KeyPad’s validity. This time is always
shown in Standard Time.

Manual Updates (¢

Should you ever have problems getting your programming base to communicate with the KeyAdvantage software
and are unable to check out KeyPads, the KeyPads can be manually updated by entering an update code.

*  Only the KeyAdvantage System Administrator can contact Supra customer support to receive update
codes and the System Administrator will be required to answer a security question before receiving
update codes.

» KeyPads that are updated by means of an update code instead of through the programming base are
not assigned to a specific user, and therefore do not assume their permissions. There are no department
restrictions. Manually updated KeyPads can open all of the dealership’s KeyBoxes, regardless of the
user’s profile in the KeyAdvantage system.

* Manually updated KeyPads are activated until midnight of that night. If you have users whose shift lasts
past midnight, Supra Support can generate a special update code for the KeyPad that allows the KeyPad
to be active until midnight of the next day.
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* The user name in a KeyPad that has been updated manually is blank. When the KeyPad is powered on,
the KeyPad displays MANUAL UPDATE MODE. When the KeyPad is in this mode, during each KeyBox
access the KeyBox verifies whether or not the update code that was entered is valid. If the update code
is valid, operation proceeds normally. If the KeyBox determines the update code is invalid, the KeyPad
emits a buzz, displays KEY EXPIRED CHECK OUT KEY, and powers down.

*  When manually updated KeyPads access a KeyBox, the KeyPad serial number is recorded in the audit
trail instead of a user name.

*  Reports with manually updated KeyPad activity will display the KeyPad serial number instead of the user
name.

To manually update a KeyPad:
1. Press the Start (2=) button to turn on the KeyPad.
2. Press the Update (¢>) button.

3. Enter the 9-digit update code. If a code shorter or longer than nine digits is entered, the KeyPad displays
INCORRECT UPDATE CODE. The KeyPad checks to see if the entered update code is valid. If it is not, the
same error message is displayed.

4. Enter a 4-digit PIN code. The KeyPad only accepts four digits for a PIN code. It ignores the Enter button if
less than four digits have been entered, and it ignores any numbers entered after four digits.

5. Press Enter.

View Error Codes

The most recent errors that have occurred using the KeyPad can be displayed on the KeyPad. This menu option
also displays the current firmware version of the KeyPad and the KeyPad’s current date and time.

« The KeyPad stores the last 16 error code entries.

»  Scroll through each error code entry, and the number of times it has occurred, using the Up and Down
Arrow (8* 2t) buttons on the KeyPad.

* Press Enter on an error code to view the error message describing the error.

*  The error code audit trail can also be viewed on the KeyAdvantage System software by placing the
KeyPad on the programming base.

See “Diagnosing KeyPads” on page 49 for details on diagnosing KeyPads.

To display the previous error codes and KeyPad firmware version:
1. Press the Start (€= ) button to turn on the KeyPad.
2. Press the KeyPad Information (§) button repeatedly to display the Error Codes menu.
3. Press the Enter button.

KeyPad Battery Status

The KeyAdvantage KeyPad operates on two AAA batteries. To display the battery level in the KeyPad:
1. Press the Start (€=) button to turn on the KeyPad.
2. Press the KeyPad Information (§) button repeatedly to display the Key Battery Status menu.
3. Press the Enter button.

4. The KeyPad reports the percent battery remaining in the KeyPad.

10
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Programming the KeyPad

When the KeyPad is connected to the KeyAdvantage software by means of the programming base, the
programming in the KeyPad can be read, diagnosed and changed. Each time that the KeyPad is placed on
the programming base during check in the vehicle access audit trail in the KeyPad is uploaded to the system
software.

Modify KeyPads

After connecting the KeyPad to the system software by placing it on the programming base, you can:

« Change the KeyPad status. Only a KeyPad in Active status can be checked out and used to access
KeyBoxes. KeyPads in Inactive or Lost status cannot be checked out.

»  Check the battery level in the KeyPad
* Change the Notes information in the KeyPad

See “Modifying KeyBoxes” on page 48 for details on modifying KeyPads.

Check Out KeyPad

KeyPads are checked out at the beginning of the key holder’s shift and are updated only for that day. When a
KeyPad is not checked out by a valid user, the KeyPad cannot access a KeyBox. KeyPads are checked out using
the KeyAdvantage programming base.

During the checkout process:
* The KeyPad assumes the permissions of the key holder as set up in the KeyAdvantage system software.

« If the KeyPad was not checked in at the end of the previous user’s shift, the KeyAdvantage software
checks in the KeyPad and uploads the previous key holder’s access activity before checking out the
KeyPad to the new user.

See “Checking Out KeyPads” on page 47 for details on checking out KeyPads.

Check In KeyPad

KeyPads are checked in at the end of the user’s shift.

During the check-in process:
» The KeyPad uploads all access activity and KeyBox read information that occurred during the shift.
* The KeyPad expires, regardless of the end-of-shift time profile of the key holder.

See “Checking In KeyPads” on page 48 for details on checking in KeyPads.

Diagnose KeyPad

The Diagnose KeyPad function is used to view KeyPad settings, programming and error information, as well as
any KeyBox read information present on the KeyPad. There are six tabs in the Diagnose KeyPads screen.

General

« Displays KeyPad programming information, including the serial number, manufacture date, check out
status, and key holder name if it is currently assigned

« If the KeyPad is currently checked out, the user name, ID, PIN, access hours and number of KeyBoxes
allowed is displayed.
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KeyBox Permission

*  When the KeyPad is checked out, this screen displays which departments’ KeyBoxes the KeyPad has
permission to access. One side of the screen shows the dealership/department permissions that should
be programmed into the KeyPad according to the KeyAdvantage software. The other side shows the
dealership/department permissions that are actually programmed into the KeyPad.

Error Log

« Displays information about the most recent KeyPad access errors, including the date, error code, and a
description of the error

» Also displays the number of times a particular error code has occurred on the KeyPad

Access Log

» Displays KeyPad date & time, KeyBox serial number, vehicle ID, purpose code used, key holder
information and KeyBox date & time for the most recent KeyBox accesses

KeyBox Read

» Displays the 35 most recent accesses to the most recently read KeyBox, including information about
when the KeyBox was accessed and by whom as well as when the KeyTag was returned to the KeyBox.
Information includes: accessing KeyPad number, user name and ID number, date and time accessed, the
KeyTag and vehicle information, the purpose code used, and the date and time of KeyTag return.

KeyBox Back Read

» Displays KeyBox access information stored in the KeyPad. Each time a key holder accesses a KeyBox,
the KeyPad stores the access information. Information includes: type of access, date and time of the
access, KeyTag serial number, vehicle ID number, purpose code used, and the date and time of KeyTag
return.

See “Diagnosing KeyPads” on page 49 for details on diagnosing KeyPads.

Flash KeyPad

The Flash KeyPad function is used when a new version of KeyPad firmware is available from Supra. After the
new firmware file is imported into the KeyAdvantage database, KeyPads are placed in the programming base and
“flashed” to update the KeyPad firmware.

See “Flashing KeyPads” on page 52 for details on flashing KeyPads.

12
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The KeyBox

The KeyAdvantage KeyBox is an electronic KeyBox that mounts on a vehicle window by means of a window
hanger. The KeyBox stores ignition keys at each vehicle for easy access.

CAUTION: The KeyAdvantage KeyBox should be removed from the window before the window is
completely rolled down and before the vehicle is driven. Damage to the vehicle may occur if it is not
removed.

The KeyAdvantage KeyBox:

Can only be accessed by active KeyAdvantage KeyPads with the correct permissions

Can be programmed to specific dealerships and/or departments to control usage

Keeps track of each person that accesses the vehicle keys and the date and time of the last 35 accesses
Access activity can also be viewed by reading the KeyBox with a KeyPad

Physical Characteristics

The KeyBox has an infrared interface that allows it to communicate with the KeyAdvantage KeyPad and
programming base.

The KeyBox has a large internal key container to accommodate the vehicle’s keys and the electronic
KeyTag to which they are attached.

The key container in the KeyBox has a bright red label which displays the KeyBox serial number.

The key container closes only if a KeyAdvantage KeyTag is properly placed in the key container. If there
is no KeyTag present, the KeyBox can close part way but does not lock and latch. In this condition, the
red label is clearly visible so that it can readily be seen which KeyBoxes do not have a KeyTag present.

The KeyBox has a jam pull tab located on the bottom of the key container. If the vehicle keys become
wedged in the key container, the jam pull tab can be used to force open the key container. The KeyBox
must first be accessed with authorized KeyPad.

Each time the KeyPad connects to a KeyBox, the KeyPad checks the KeyBox’s battery level. If the
battery level falls below 1%, the KeyPad buzzes and displays a BOX BATTERY LOW message.

=
G
KayAdvantage
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Programming the KeyBox

When the KeyBox is connected to the KeyAdvantage software by means of the programming base, the
programming in the KeyBox can be read, diagnosed, and changed.

KeyBox Assignments

+ All KeyAdvantage KeyBoxes are programmed with an owner system code that cannot be changed. Every
customer has a unique owner system code to prevent unauthorized access.

» During system configuration, the customer determines whether they will be assigning KeyBoxes to
dealerships and/or departments. Establishing departments is a Supra configuration function and cannot
be performed by the dealership administrator.

* If KeyBox assignments are available, each KeyBox can be programmed to allow access only by key
holders within a dealership group, a single dealership, specific departments within a dealership or group
of dealerships. For example, you may allow some key holders access to the New and Used car sales
KeyBoxes at one dealership and another group of key holders access to KeyBoxes assigned to the
Service department for several dealerships.

« If KeyBox assignments are being used, when inventory is ordered from Supra the KeyBoxes are
programmed to dealership groups, dealerships, and departments so that the administrator can control
which groups of key holders can access which KeyBoxes.

« The dealership group code, dealership code, and department code can also be programmed by the
dealership using the programming base.

See “Programming KeyBoxes” on page 54 for details on programming KeyBoxes.

KeyBox Access Records
* The KeyBox stores the most recent 35 accesses.

» KeyBox access activity is stored on a first-in, first-out rolling basis. When the 36th access occurs and is
recorded in the KeyBox, the first entry is removed.

When the KeyBox is accessed by a KeyPad, the KeyBox records:
*  Who took the vehicle keys—the key holder ID and user name assigned to the KeyPad
*  Which vehicle keys were taken—the KeyTag ID and vehicle information
*  When the vehicle keys were taken—date and time in the KeyBox
*  Why the vehicle keys were taken—which purpose code was used

Restrict KeyBox access

+ KeyAdvantage system operators, managers and administrators have the ability to restrict access to
KeyBoxes.

» KeyBoxes can be programmed with a lockout list that prevents specified KeyPads from accessing the
vehicle keys. To add a KeyPad serial number to the lockout list for a KeyBox, the KeyBox must be
programmed on the programming base. See “Lockout List” on pages 6 and 54 for details on programming
lockout lists in KeyBoxes.
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User Operations

KeyBox user operations include accessing vehicle keys, viewing KeyBox access information, and modifying,
programming, and diagnosing the KeyBox. Visit www.keyadvantage.com to view more KeyAdvantage
documentation.

Access Vehicle Keys

Note: The KeyBox can only be accessed by a KeyPad that has been
checked out by a key holder with permissions to open that KeyBox.

To open the KeyBox to obtain vehicle keys:
1.

2.
3.
4

When the KeyPad has unlocked the KeyBox, press up on the
key container to release it and access the vehicle keys.

Note: The key container must be released within one second
of pressing up or the key container will re-lock.

To relock the key container, push the key container back up
into its locked position. A KeyTag must be in place for the
key container to lock. The KeyPad is not needed to close a
KeyBox.

The key container has two contacts that recognize when

a KeyTag is attached to the KeyBox. The KeyTag must be
correctly inserted into the key container so the contacts in the
KeyBox can read the serial number of the KeyTag.

Press the Start (€= ) button to turn on the KeyPad.
After the KeyPad displays the user name, enter the 4-digit PIN code and press the Enter button.
Enter the purpose code and press the Enter button.

Connect the KeyPad to the KeyBox using the IR ports. The key holder has up to two minutes to connect
with the KeyBox.

When you hear the operation complete tones (4 short beeps), press up on the key container to release it
and access the vehicle keys.

After authorization has been granted, the user has 12 seconds to access the KeyBox.

View KeyBox Access Information

When an authorized KeyPad accesses a KeyBox, the access information for that event and the previous
event are recorded in the KeyPad.

KeyBox access information can be viewed on a KeyPad or in the KeyAdvantage software through the use
of a programming base.

Performing a Read KeyBox function with the KeyPad downloads the last 35 access records from the
KeyBox to the KeyPad.

— The first five access records can be immediately viewed on the KeyPad or accessed at a later time.

— The most recent vehicle access data is displayed on the KeyPad first. Additional access records can
be displayed by scrolling. Navigation through the records is bidirectional.

— The user name and KeyTag serial number are displayed first on the screen. Press Enter to display
the corresponding date and time of the record.

— When the KeyPad is checked in at the end of the shift, the KeyBox read is downloaded to the
KeyAdvantage software where it can be viewed in the form of Access reports.


http://http://www.suprasystems.com/Products/Pages/KeyAdvantage.aspx
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See “PIN Code” on page 28 for details on creating Access reports.

To read a KeyBox:

1.
2.
3.

4.

Press the Start (€=) button to turn on the KeyPad.
Press the KeyBox Information ([=]) button until the Read Box menu is displayed.

Press the Enter button and connect the KeyPad to the KeyBox using the IR ports. User information for
the most recent access is immediately displayed, press the Enter button to view the date and time of the
KeyBox access.

Press the Down Arrow (8+) button to view the next KeyBox access record.

To view the last KeyBox read:

1.

2.
3.
4

Press the Start (€= ) button to turn on the KeyPad.

Press the KeyBox Information ([=3]) button until the View Last Read Box menu is displayed.
Press the Enter button to view the date and time of the KeyBox access.

Press the Down Arrow (8+) button to view the next KeyBox access record.

Modifying the KeyBox

The KeyBox status and notes can be modified without placing the KeyBox on a programming base. In addition, an

activity report can be generated for an individual KeyBox. The Modify KeyBox menu option allows users to view
the following KeyBox information:

Serial number

Status

Programmed date

Battery status

Notes

Lockout list

Current department assignment
Activity report

Programming the KeyBox

When the KeyBox is connected to the KeyAdvantage software by means of the programming base, the
programming in the KeyBox can be read, diagnosed and changed. Each time that the KeyBox is placed on the
programming base, the vehicle access audit trail in the KeyBox is uploaded to the system software.

After connecting the KeyBox to the system software by placing it on the programming base you can:

See “Modifying KeyBoxes” on page 53 and “Programming KeyBoxes” on page 54 for details
on modifying and programming KeyBoxes.

Change the KeyBox status. Change the status of KeyBoxes that have been lost or
damaged to Inactive

Check the battery level in the KeyBox
Add or delete KeyPads from the KeyBox lockout list

Change the dealership/department assignments that determine where the KeyBox
can be placed

Add notes about the KeyBox

16
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Diagnosing the KeyBox

The diagnostic function is used to view settings, programming and error information on the KeyBox. There are
four tabs in the Diagnose KeyBoxes screen.

General Tab

» Displays KeyBox programming information, including the serial number, manufacture date and current
lockout list

KeyBox Permission Tab

» Displays the KeyBox dealership/department assignment defined in the KeyAdvantage software as
compared to the dealership/department assignment that is actually programmed in the KeyBox.

Access Log

» Displays KeyPad serial number, user information, KeyTag number, vehicle assignment information and
date & time for the most recent KeyBox accesses, as well as the date and time that the KeyTag and
vehicle key were returned to the KeyBox

Error Log
» Displays the most recent KeyBox errors, along with the date and time that the error occurred.

See “Diagnosing KeyBoxes” on page 55 for details on diagnosing KeyBoxes.
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The KeyTag

The KeyAdvantage KeyTag is used to attach vehicles keys to KeyBoxes and to track the activity of the vehicle
keys.

* Vehicle keys are securely attached to the KeyTag with a tamper-evident KeyTag attachment.

» Because the KeyBox recognizes when a KeyTag is present, the KeyTag is used to track accesses to a
particular vehicle’s keys.

Physical Characteristics

* The KeyTag has metal contacts that connect to the KeyAdvantage KeyBox. The contacts in the key
container recognize when the contacts of a KeyTag are present and therefore that the vehicle keys are
present.

*  When the KeyTag makes contact with the KeyBox, the KeyBox reads the serial number and the vehicle ID
information programmed into the KeyTag.

» If the metal contacts of the KeyTag do not connect with the KeyBox, the key container will not completely
close, providing visible evidence that the vehicle keys are not present.

* The KeyTag attachment is secured to the vehicle keys using a crimp tool. Do not use vehicle key rings on
the KeyTag.

KeyTag Programming

» KeyTags are assigned to and unassigned from specific vehicles using the KeyAdvantage software and
programming base.

See “Assigning KeyTags” to Vehicles on page 44 for details on assigning KeyTags.
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The KeyCaddy

The KeyCaddy is a metal hoop that holds up to 50 KeyTags with vehicle keys attached. It allows for fast and easy
removal and replacement of the vehicle keys in and out of the KeyBoxes. The KeyCaddy can be attached to a
shoulder strap for convenient carrying during nightly key removal or daily replacement.
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The Programming Base

The KeyAdvantage programming base provides a programming interface between the KeyAdvantage software
and KeyPads, KeyBoxes and KeyTags.

The programming base is capable of reading and writing KeyBoxes, KeyPads and KeyTags. It is used to program,
deprogram, and troubleshoot KeyBoxes and KeyPads. It can read serial number of KeyTags and program vehicle
IDs into the KeyTag.

Physical Characteristics

The programming base:

Communicates with KeyBoxes, KeyPads, and KeyTags to allow information to be passed between these
devices and the KeyAdvantage software

Contains receptacles for docking KeyBoxes, KeyPads, and KeyTags. Only one device can communicate
with the programming base at a time

Communicates with KeyBoxes and KeyPads through IRDA (infrared) communication. The programming
base connects to the KeyTag through physical contacts

Connects to a PC through a serial connection

Visual Feedback—LEDs

The front panel contains 5 LEDs for visual feedback.

When the programming base is powered on, all lights quickly blink on and off.

The red LED indicates that the power switch is on and that power is applied. If the red light is off there is
no power.

The green PC light indicates the serial cable is connected. If the green PC light is off it indicates the cable
is not connected.

The green COMM light indicates the software is connected to the base. If the green COMM light is off it
indicates the software is not connected to the base.

The yellow IR light indicates a KeyPad or KeyBox is connected to the base.
The yellow TAG light indicates a KeyTag is connected to the base.
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User Operations

The programming base reads and writes programming information to KeyBoxes and KeyPads and downloads
diagnostic information and audit trails. The programming base is used to:

*  Program, diagnose and read KeyBoxes

*  Program and diagnose KeyPads

* Check KeyPads in and out

*  Program, unassign and read the serial number and assigned vehicle ID in KeyTags

* Assigning KeyBoxes to dealerships & departments
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Software Overview

The KeyAdvantage system software maintains all KeyAdvantage data. System administrators primarily use the
KeyAdvantage software to control access to vehicle keys. The software consists of a database that stores user
and group information, vehicle information, inventory and assignment data on KeyPads, KeyBoxes, and KeyTags,
and vehicle access activity. Visit the www.keyadvantage.com website to view more KeyAdvantage documentation
and download the current software.

Setting up and administering the system includes:

» Creating a user profile for each software user and key holder, defining their work hours, department, PIN
code, and number of accesses allowed per day

* Managing user and KeyAdvantage inventory status

* Importing KeyAdvantage device inventory into the system software
« Entering vehicle information into the system software

* Assigning KeyTags to a vehicle key

* Assigning KeyBoxes to dealerships & departments

* Placing KeyBoxes containing vehicle keys on each vehicle

¢ Maintaining the database

*  Scheduling and reviewing reports to manage users and vehicle inventory

System Users

The KeyAdvantage software allows administrators to create two types of users—those who are able to check
KeyPads in and out, and those who can log into the KeyAdvantage software to perform administrative tasks.

KeyAdvantage Key Holders

+ KeyAdvantage key holders only have access to the KeyAdvantage system software to check in and check
out KeyPads.

*  When a key holder record is created, the following information is entered:
— Alogin ID and password that allows them to log into the software to check in and out KeyPads

— AKeyPad user name that appears on the screen of the KeyPad when it is powered on and in access
reports

— Ad4-digit PIN code
— The maximum number of KeyBoxes that they can access during their shift
— The number of KeyPads that they are allowed to check out simultaneously

— Specific times on specific days during which they can check out KeyPads and open KeyBoxes to
access vehicle keys

— The department(s) in which they are allowed to access vehicle keys

See “Creating Users and Key Holders” on page 36 for details on creating key holders.

Key Holder Groups
* Key holders can be organized into groups.
»  All group members have identical permissions and access hours.

» Key Holder groups can be cross-dealership, restricted to a single department within a dealership, or
anything in between.


http://http://www.suprasystems.com/Products/Pages/KeyAdvantage.aspx
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Note: To change permissions for a single key holder within a group, the user must first be removed from
the group.

Key holders can be assigned to existing groups when the user login is created, or multiple key holders
can be added to a new group when it is created or at any later time.

Note: Key holders can be assigned to only one key holder group at one time.

See “Creating Key Holder Groups” on page 35 for details on creating key holder groups.

KeyAdvantage Software Users

KeyAdvantage system administrators can be set up with several levels of system access and
administrative privileges, including the ability to manage KeyAdvantage inventory, create and schedule
reports, and create additional users with lower permission levels than themselves.

Note: No user can assign another user permissions which they themselves do not possess. This means
that if a key holder or group has permissions across dealerships, only the customer super administrator or
dealership group administrator can change their permissions. If an administrator has permissions across
dealership groups, only the customer super administrator can change the permissions.

In addition to key holder, there are five (5) levels of software user: Operator, Dealership Manager,
Dealership Administrator, Dealership Group Administrator, and Customer Super Administrator. Each
has increasing levels of privileges. Custom users can be created by either adding or removing privileges
assigned to the five predefined software user types.

See “System Users” on page 23 for details on creating system users.

KeyAdvantage Operator

KeyAdvantage operators have basic administrative privileges. An operator can:

Create, modify, import, and delete vehicle inventory

Assign and unassign KeyTags

Configure and program KeyBox lockout list

Diagnose KeyBoxes and KeyPads

Modify KeyBox notes and status

View, print, export, and email Reconciliation, KeyBox Inventory, and Vehicle Inventory reports

KeyAdvantage Dealership Manager

KeyAdvantage dealership managers have the same administrative privileges as the KeyAdvantage operator. In
addition, the dealership manager can:

Override the KeyBox Access Limit when a key holder attempts to check out a KeyPad after the access
limit has been reached

View, print, export, and email Access, Assignment, and History reports
Flash KeyPads with updated firmware

KeyAdvantage Dealership Administrator

KeyAdvantage dealership administrators have the ability to perform administrative tasks related to inventory and
users within the dealership they administer. In addition to the privileges of the operator and dealership manager,
the dealership administrator can:

Create, modify, and delete key holders, system operators, and dealership managers
View records for all keyholders who have access to the dealership’s KeyBoxes
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* Import KeyBox, KeyTag, and KeyPad inventory files, system configuration files, and KeyPad firmware files
into the KeyAdvantage software

* Assign, unassign, delete, modify, and program KeyBoxes
*  Modify and program KeyPads
*  View, print, export, and email Configuration reports

KeyAdvantage Dealership Group Administrator

The KeyAdvantage dealership group administrator has the ability to perform administrative tasks related to
inventory and users across dealerships within a dealership group. Dealership group administrators can:

*  Perform tasks of the operator, dealership manager, and dealership administrator across several
dealerships

» Create, modify, and delete key holders, system operators, dealership managers, and dealership
administrators for the dealership group they administer

KeyAdvantage Customer Super Administrator

The KeyAdvantage customer super administrator has complete access to all administrative functions and
privileges across dealerships and dealership groups. The customer super administrator can:

» Create, modify, and delete key holders, system operators, dealership managers, dealership
administrators, dealership group administrators, and other customer super administrators

»  Configure dealership system settings, such as defining purpose codes, and email options for automatic
system notifications

« Backup, restore, purge, archive, and unarchive the entire KeyAdvantage database, configuration data,
and user information data

User and Product Status

Statuses are used to manage users and product inventory in the KeyAdvantage software.

System User Status
There are two statuses for KeyAdvantage system users: Active and Inactive.

* Active status—the user is in good standing, can log into the KeyAdvantage software, and can check out
KeyPads.

* Inactive status—the user is not in good standing or is no longer an employee of the dealership. They
cannot access the KeyAdvantage system to use the system software or to check out KeyPads.

Key Holder Group Status
There are two statuses for KeyAdvantage key holder groups: Active and Inactive.

* Active status—users in the group in good standing can log into the KeyAdvantage software and can
check out KeyPads.

* Inactive status—users in the group cannot log into the system software or check out KeyPads, even if the
individual user’s status is Active.

KeyPad Status

After a KeyPad has been imported into your KeyAdvantage system software, the status of the KeyPad can be
changed.
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There are three statuses for a KeyPad:
* Active—can be checked in and checked out
* Inactive—can be checked in but not checked out
* Lost—can be checked in but not checked out

KeyBox Status

After a KeyBox has been imported into your KeyAdvantage system software, the status of the KeyBox can be
changed.

Note: The status in a KeyBox does not prevent it from being accessed by an updated KeyPad.

There are two statuses for a KeyBox:
+ Active—KeyBox is assigned to a dealership/department and is being used to house vehicle keys.
* Inactive—currently not assigned. Inactive KeyBoxes can still be accessed.

KeyTag Status

KeyTags are assigned to vehicle keys by placing the KeyTag on the programming base and connecting to the
KeyAdvantage software. KeyTags have two statuses:

» Assigned—KeyTag is associated with a specific vehicle in the KeyAdvantage software.
* Unassigned—not actively assigned to a vehicle in the software.

See “Assigning KeyTags to Vehicles” on page 44 and “Unassigning KeyTags from Vehicles” on page 45 for details
on assigning and unassigning KeyTags.

Importlng KeyAdvantage Inventory Files

KeyPads and KeyBoxes ordered from Supra must be imported into your system software so that they can
be assigned and accessed.

* Inventory shipped from Supra includes a .supra file containing your inventory information.

*  Customer Super Administrators, Dealership Group Administrators, and Dealership Administrators have
permissions to import inventory files.

Note: If a KeyPad accesses a KeyBox that is not in the database, the KeyPad cannot be checked in until
the KeyBox has been imported into the database.

See “Importing Vehicle Information” on page 43 for details on importing files.

Entering Vehicle Information
Before the vehicle keys can be assigned to a KeyTag, the following vehicle information is entered:
* VIN and/or stock number
*  Vehicle make
*  Vehicle model
* Vehicle year
« Status of vehicle—Active, Inactive, Lost, or Sold
*  The department in which the vehicle is located

The vehicle information database is self-building so that once a particular vehicle make, model, year or color
has been entered once, it is added to the drop-down menu and does not need to be typed in again. Vehicle
information can be typed manually into the KeyAdvantage system or imported from a flat text file.
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See “Entering Vehicle Information” on page 42 for details on entering, modifying, and importing vehicle
information.

Assigning KeyTags

Assign KeyTags to a vehicle through the Vehicle screen in the KeyAdvantage software, placing the
KeyTag on the programming base and selecting Assign KeyTag.

« Unassign KeyTags easily through the Vehicle screen in the KeyAdvantage software, placing the KeyTag
on the programming base and selecting Unassign KeyTag or through the Unassign KeyTag shortcut
button.

See “Assigning KeyTags to Vehicles” on page 44 for details on assigning KeyTags.

Maintaining the KeyAdvantage Database

KeyAdvantage software administrators can perform database maintenance functions including backing up,
archiving, and purging data, as well as restoring the entire database.

Backing Up Data
» System data can be backed up to either a local or mapped network drive.
»  The backup can be scheduled to run at a specific time each day, or it can be initiated at any time.

Archiving Data

» Both transaction and history data can be archived to improve system performance. Archived data is
stored separately on the server and is not displayed in Activity reports.

» Data can be archived at any time or scheduled to archive automatically at a specific monthly interval.
« Archived data can be retrieved at any time using the Unarchive Data function.
* Archived back-up data is deleted after 7 days.

Purging Data
» Sold vehicle inventory can be purged at any time to improve system performance.

» Purged data is permanently deleted and does not display in Activity reports. System data should be
backed up before the vehicle data is purged.

Restoring the Entire Database
* The entire KeyAdvantage database can be restored from a backup file stored locally on the server.

See the “Database Maintenance” chapter on page 61 for details on backing up, archiving, unarchiving, and
purging data.

System Configuration

The customer super administrator has the ability to change some system configuration information. There are four
tabs in the Configuration menu.

Customer Details

*  The customer address can be modified.
Option Setting

»  Configurable purpose codes can be defined.
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* The use of KeyTag duration tracking can be activated or deactivated.

Dealership Group Dealership Department

« The information on this tab is established during the original system configuration and can only be
changed by Supra.

Customer Site Options
»  Contains networking information that should only be changed by your IT administrator.

KeyAdvantage Reports

Various reports are available for operators, managers and/or administrators to assist them in managing the
KeyAdvantage system. Reports are available to tell you who has KeyPads, which vehicles are being shown, who
is or isn’t showing vehicles, who is accessing vehicles for what purpose, and the status of the KeyPads. Reports
can be automatically generated and emailed to managers. See the “Reports” chapter on page 59 for details on
creating and scheduling reports.

Reports fall into six categories: Access, Assignment, Reconciliation, Inventory, Configuration, and History.

Access Reports

There are four Access reports: Key Holder Access, Vehicle Access, Demo Activity Access, and Purpose
Summary.

Note: Duration tracking must be activated in the configuration file to be viewable in Access reports.

Key Holder Access Report
* Reports which KeyBoxes key holders have accessed within a specified date range
« Can be set to report activity by key holder, key holder group or by KeyPad serial number
» Can be set to report only accesses using specified purpose codes

* Can be set to report only the accesses of a specified duration of time during which the vehicle keys were
out of the KeyBox. Vehicle keys must be removed at the end of the day to view the duration of the last
vehicle access.

» Displays key holder information, the date, time and duration of access, purpose code used, vehicle
information, KeyTag serial number, dealership and department to which the KeyBox is assigned

» Displays the KeyPad serial number instead of user information when access was made by a KeyPad in
Manual Update mode

Vehicle Access Report
* Reports which vehicle keys, by department, have been accessed within a specified date range
* Can be set to report only access using specified purpose codes

» Displays the dealership group, dealership and department information, date, time and duration of access,
purpose code used, vehicle information, KeyTag serial number, dealership and department to which the
vehicle key is assigned

Demo Activity Access Report

* Reports number of times that designated vehicles have been accessed (based on KeyTag assignment)
for sales demos during a specified date range

« Data divided into separate sections for each department within each dealership
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» Displays key holder information, and date, time and duration of access for the three most recent sales
demo accesses

Aging Snapshot Access Report

+ Summarizes the age of vehicles and the number of sales demo accesses for those vehicles during a
specific time period

« Displays the dealership name, department, VIN/stock number, age of vehicle, and demo activity

Purpose Summary Report
« Summarizes how many KeyBoxes a key holder has accessed using each purpose code

» Displays key holder ID and name, as well as number of accesses made using each purpose code

Assignment Reports

There are two Assignment reports: Current KeyPad Assignment and KeyPad Assignment History.

KeyPad Assignment Report
»  Shows current assignment of all KeyPads that are checked out
« Can be configured for any or all key holders, and expired or in-use KeyPads
» Displays key holder ID and name, as well as date and time of checkout and expiration

KeyPad Assignment History Report
*  Shows KeyPad assignment history within a specified date range
» Can be configured by any or all key holders, key holder groups, or KeyPad serial numbers
» Displays key holder ID and name, as well as date and time of checkout and expiration

Reconciliation Reports

There are two Reconciliation reports: Vehicle Key Removal and KeyTag.

Vehicle Key Removal Reconciliation Report
» Used to confirm that all vehicle keys have been removed from KeyBoxes during nightly removal

» Displays vehicle, dealership, and department information for all KeyTags not removed using the Night
Removal purpose code

KeyTag Reconciliation Report

»  Used for two functions: Determining if any KeyTags are assigned to vehicles that are in Sold status, and
determining if there are vehicles that have no KeyTag assigned to them

« Can run either parameter as separate reports or combined on one report
« Can be configured for all dealerships/departments, or just selected ones

» Displays vehicle, dealership and department information, along with the vehicle or KeyTag status

Inventory Reports

There are three Inventory reports: KeyPad Inventory, KeyBox Inventory, and Vehicle Inventory.
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KeyPad Inventory Report
«  Summarizes KeyPad inventory information
« Can be configured by any or all KeyPad serial numbers, inventory status, or battery status

» Displays KeyPad serial number, inventory status, battery status, checkout status, assignment status,
current firmware version, user ID, and user name

KeyBox Inventory Report
*  Summarizes KeyBox inventory information
» Can be configured by any or all KeyBox serial numbers, department, inventory status, or battery status
» Displays KeyBox serial number, inventory status, battery status, VIN, and stock number

Vehicle Inventory Report
*  Summarizes vehicle inventory information
« Can be configured by department and vehicle status

» Displays VIN, stock number, year, make, model, color, status, and KeyTag serial number

Configuration Reports

There are three Configuration reports: System User Configuration, Key Holder Configuration, and Key Holder-
KeyPad Assignment Configuration.

System User Configuration Report
« Shows KeyAdvantage software authorization levels of users
* Displays Dealership name, user ID number, user name, and authorization level

» Can be configured for all users or by specific login permissions

Key Holder Configuration Report
»  Summarizes key holder access hours

» Displays key holder user ID, last and first name, and access hours for each day of the week by
department

» Can be configured for any or all key holders, by key holder status, or by department

Key Holder-KeyPad Assignment Configuration Report
» Displays detailed information about the KeyPads assigned to specific key holders
* Only available if your system is configured to assign KeyPads to key holders

* Includes user ID, user name, key holder status, KeyPad status, KeyPads assigned, and KeyPad check
out status

History Reports
There are two History reports: Record Change History and Admin Change History.

Record Change History Report
« Summarize all changes made to records within a selected date range
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» Changes for a single record can be viewed by clicking the View Change History button within the record

* Options include user change history, KeyBox permissions or access hours change history for key holders
or key holder groups, user login permissions change history, key holder group assignment change history,
key holder group change history, database maintenance activity history, key holder/KeyPad assignment
change history, and KeyPad flash change history

Admin Change History Report
» Displays all record changes made within a selected date range by a specific Admin user

»  Options include user change history, KeyBox permissions or access hours change history for key holders
or key holder groups, user login permission change history, key holder group assignment change history,
key holder group change history, database maintenance activity history, key holder/KeyPad assignment
change history, and KeyPad flash change history

Scheduling Reports

Access, Assignment, and Reconciliation reports can all be set up to be automatically generated and delivered to
an email address. This is useful for monitoring activity and inventory.

See “Scheduling Reports for Automatic Distribution” on page 59 for details on scheduling reports for automatic
distribution.

Scheduled Reports:
* Can be set up in .RTF (rich text format) or as Microsoft Excel spreadsheets, or both
* Can be sent to multiple email addresses
* Can be set to automatically run daily, weekly, monthly or on-demand

» Can be set to a frequency of None which saves the report so that it can be run and delivered on demand
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Chapter 2. Getting Started
Logging on to KeyAdvantage

Log on to the KeyAdvantage software to perform the tasks necessary to maintain your KeyAdvantage system.

To log on to the KeyAdvantage software, do the following:
1. Start the KeyAdvantage software. The KeyAdvantage Login screen displays (Figure 1).

Figure 1. KeyAdvantage login screen

KeyAdvantag:

KeyPad Check Out KeyPad Check In

K
Login

Click Login. The Login window displays.
3. Enter your login ID and password (Figure 2).

Note: The dealership system administrator creates the login ID and password during the KeyAdvantage
Software installation process. The dealership system administrator can set up login IDs and passwords for
others needing access to the KeyAdvantage software.

Figure 2. Enter login ID and password

5

Login [0
|F|.-'-‘-.nu:|ersu::n |

Fazzword

[P |

Login I Cancel |

4. Click Login.

The menu options available to the user when logged on to the KeyAdvantage software depend on the
permissions set up by the administrator when creating the user record.

If the KeyAdvantage software detects no activity from the user for more than 20 minutes, it will automatically log
the user off the application.
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KeyAdvantage Software Toolbars
KeyAdvantage has the following toolbars:

Main toolbar. The Main toolbar (Figure 3) contains buttons that are shortcuts to common tasks in the
KeyAdvantage software. The name of the button displays when you position the mouse cursor over it.

Figure 3. Main toolbox

Unassign Modify Check in Modify

KeyTag users KeyPads Keyboxes Cut Paste
=~ i1 Bime g BE 0 X BB X
Modify Reports Check out Modify Program Copy Logout
vehicle KeyPads KeyPads KeyBoxes
information

Screen toolbar. The Screen toolbar (Figure 4) provides the tools used in the KeyAdvantage screens. If a
button is dimmed, it is currently unavailable.

Figure 4. Screen toolbar

First Next

Add new Modify Save record record
S0 a2L2o>@ X KkEa i
Search Copy current Cancel Delete Previous Last
record changes record record

Report toolbar. The Report toolbar provides the tools for viewing reports (Figure 5).

Figure 5. Report toolbox

New Modify Save Print E-mail

| | | | |
lE"fD?f/TEIIr%@.%IﬁJ

Copy Delete Cancel Print Export
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Importing KeyAdvantage Inventory

Use the Import inventory function to import a dealership configuration file or KeyAdvantage inventory information.
When Supra sends an order of new KeyBoxes or KeyPads, it includes an inventory file that contains information
needed by the KeyAdvantage software. You must import the inventory file into the KeyAdvantage software before
using the KeyBoxes or KeyPads.

To import an inventory file, do the following:

1. Click File > Import. The Import window displays (Figure 6).

Figure 6. Import window

KeyAdvantage-->Import-->[Supra] -10] =]
J Browsze | Impart I
[

Lloze |

Note: If a dialog box opens prompting you to enter a CD key, enter the CD key validation number printed
on the back of the KeyAdvantage software installation CD package.

Impaort O ata From

Click Browse.

Locate the .supra inventory file. Highlight the file and click Open.
Click Import.

Click Yes to view the log file.

If you have another inventory file to import, repeat the process.
Click Close.

S S R

Creating Key Holder Groups

Key holder groups categorize key holders who access the same KeyBoxes during the same working shift. You
can assign key holders that have the same working hours and access to the same KeyBoxes to a key holder
group for easier key holder data entry. Examples of key holder groups include New vehicle sales, Used vehicle
sales, and Service department. The access hours and KeyBox access permissions of a group are applied to all
key holders within a group.

To create a key holder group, do the following:
1. Click Users > Modify key holder group. The Modify Key Holder Group window displays (Figure 7).
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Figure 7. KeyBox Access Permission tab
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Click Add new.

3. Enter a name for the group.
Select the status from the dropdown list.
Active—The key holders can check out KeyPads.

Inactive—The key holders cannot check out KeyPads. Making a key holder group status inactive
prevents all key holders within the group from checking out a KeyPad.

5. Enter the hours the key holders are allowed to access vehicles. If the hours are the same each day of the
week, enter the hours in the first line and check the Apply all box.

Check the dealerships and departments the key holder group should be able to access.
Click Save.

Creating Users and Key Holders

To create a new user or key holder, do the following:
1. Click Users > Modify Users.
2. Click Add new.
3. Select the user status from the dropdown list.

Active—The user can check out KeyPads and/or log on to the KeyAdvantage software.
Inactive—The user cannot check out KeyPads or log on to the KeyAdvantage software.
If a user no longer works for the dealership, change the status to /nactive.

4. Enter the user’s first and last names.
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Figure 8. KeyBox Access Permission tab
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Enter a login ID for the user. The login ID is used when the user logs onto the KeyAdvantage software or
when checking out a KeyPad.

Enter the employee number and any applicable notes.
Enter the KeyPad user name. This displays on the KeyPad when it is powered on.

Enter and confirm a four-digit PIN code for the key holder. The key holder uses his PIN code when
checking out a KeyPad and accessing KeyBoxes.

Enter the maximum number of KeyBox accesses the user can use in a shift.
Enter the maximum number of KeyPads the user can check out at a time.
To enter the access hours and KeyBox access permissions, do one of the following:

a. If the key holder belongs to a key holder group, select the group from the dropdown list. The key
holder group settings automatically fill in the access hours and KeyBox access permissions, which
cannot be changed.

b. If the key holder does not belong to a key holder group, manually enter the access hours and KeyBox
access permissions by doing the following:

« Enter the hours the key holder is allowed to access vehicles. If the hours are the same each day of
the week, enter the hours in the first line and check the Apply all box.

» Check the dealerships and departments the key holder can access.

Note: /f a new dealership department is added to your KeyAdvantage system at a later date, you will
need to add the new department to the KeyBox access permissions of all users needing access to the
department. If the KeyBox access permissions are not updated in the user profiles, those employees will
not be able to access the new department KeyBoxes.

If the user only needs to be able to check in and check out KeyPads, you can skip the following steps
and save the user record. This saves the user as a key holder and does not allow the user to access any
other function of the KeyAdvantage system.

If the user needs to access the KeyAdvantage software menus, click the Login Permissions tab. The
Login Permissions tab becomes active, as shown in Figure 9.
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Figure 9. Login permissions tab
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14. Click Set Permissions and select the user type from the dropdown list.

Note: You cannot create a user with login permissions that exceed your own.

15. Check/uncheck any KeyAdvantage functions and click OK. If you add or remove any functions, the
program will save the user as Custom in the User type field.

16. Enter and confirm a password for the user. The user logs on to the KeyAdvantage software using the
login ID and password. The password must contain a minimum of eight characters and at least one

numeral, one uppercase character, and one lowercase character.
17. Check the dealerships and departments the user should be able to access.

18. If you've configured your system to assign KeyPads to specific key holders, click the Configure KeyPads

tab. The Configure KeyPads tab becomes active, as shown in Figure 10.
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Figure 10. Configure KeyPads tab
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19. From the Available KeyPads list on the left, select the serial numbers of the KeyPads you wish to assign
to the key holder.
20. Click the arrow button to add KeyPads to the Assigned KeyPads list on the right.
21. Click Save.

Assigning Key Holders to Groups

Once the key holders have been entered into the KeyAdvantage system, they can be assigned to a key holder
group. To assign key holders to groups, do the following:

1. Click Users > Modify Key Holder Group.
2. Click Search.

3. Enter or select the search criteria in any active field. Both the asterisk (*) and the percent sign (%) can be
used as wildcards when searching for a record.

4. Click Find.

If necessary, scroll through the records using the arrow buttons at the top of the screen to locate a
specific key holder group.

Click the Modify Current Record button.

Click the Key holder assignment tab. The Key holder assignment tab becomes active, as shown in
Figure 11.
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Figure 11. Key Holder Assignment tab
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8. Highlight users and click the right arrow button to add them to the group.
9. Click Save.

Assigning KeyPads to Key Holders

The KeyAdvantage system can be configured to do one of the following:
« Assign KeyPads to specific key holders.
* Allow key holders to check out any KeyPad.

Before you can assign KeyPads to specific key holders, you must configure your system to do so. Administrators
can enable the Assign KeyPads to key holders option in the Administrator > Configuration menu under the
Customer site options tab.

To assign a KeyPad to a key holder, do the following:
1. Click Modify Users on the Users menu.

2. Click Search.

3. Enter or select the key holder search criteria in any active field.

4. Click Find.

5. Click the Configure KeyPads tab. The Configure KeyPads tab becomes active, as shown in Figure 12.
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Figure 12. Configure KeyPads tab
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Click the Modify Current Record button.

Select the serial numbers of the KeyPads you wish to assign to the key holder from the Available
KeyPads list on the left.

8. Click the arrow button to add KeyPads to the Assigned KeyPads list on the right.
9. Click the Save button.

To unassign KeyPads from a key holder, select the KeyPad serial numbers in the Assigned KeyPads list and click
the left arrow button to return them to the Available KeyPads list.

Viewing Change History
The KeyAdvantage software allows you to view the individual record change history for the following:

Users—User information, KeyBox access permissions, login permissions, and KeyPad assignment.

Key Holder Groups—Key holder group details, KeyBox access permissions, and key holder assignment.

To view the change history for a user or key holder group, do the following:
1. Click Users > Modify Users or Modify Key Holder Group.
2. Click Search.

3. Enter or select the search criteria in any active field. Both the asterisk (*) and the percent sign (%) can be
used as wildcards when searching for a record.

4. Click Find.

Click the View Change History button in the section of the record where you want to see the change
history. For example, if you want to view the login permissions change history for a user record, click
the Login Permissions tab, then click the View Change History button. The View Change Window will
appear, as shown in Figure 13.
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Figure 13. View change history button in login permissions tab
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Entering Vehicle Information

You must enter the vehicle information into the KeyAdvantage System before a KeyTag can be assigned to the
vehicle.

To enter a vehicle information, do the following:

1. Click Vehicle Information > Modify Vehicle Information. The Modify Vehicle Information window
displays, as shown in Figure 14.

Figure 14. Modify vehicle information window
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2. Click Add New.
3. Enter the VIN.
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Enter the stock number.

Enter the year or select the year from the dropdown list.

Enter or select from the dropdown list the make, model, and color of the vehicle
Enter any applicable notes.

Assign the vehicle to a department by checking the appropriate box.

Click Save.

You must enter the VIN or stock number and assign it to a department. The remaining fields are optional.

Importing Vehicle Information

The KeyAdvantage software allows you to import vehicle information from a flat file into the vehicle database.
In order to be imported successfully, the file must be a text (. TXT) file in tab-delimited format. The following nine
columns are required and must be listed in order:

1.

© ® N o 0o R~ DN

VIN number (17 characters)

Stock number (10-character limit)

Year (4 characters)

Make (20-character limit)

Model (20-character limit)

Color (20-character limit)

Status (A=Active, |=Inactive, L=Lost, S=Sold)
Note1 (50-character limit)

Note2 (50-character limit)

You must include all nine fields in the vehicle data file, even if no data is present. The blank fields create
placeholders and ensure that the vehicle data is imported into the correct fields in the database. Press the Tab
key to create a field placeholder when no data is present.

Note:

The VIN or stock number is required for the data to be imported. All other values, such as make, model,

and year, are optional.

To import a vehicle file into the KeyAdvantage database, do the following:

1.

Click Vehicle Information > Import Vehicle Information. The Vehicle Import window displays, as shown

in Figure 15.

Figure 15. Vehicle import window

2.
3.
4.

Import Diata From

C:ADocuments and S ettingz A dministratoridy
Documents\Wehicle D ata. tst

Click Browse to locate the vehicle data file on the computer.
When the vehicle data file is shown in the Import Data From box, click Import.

Select the department to which you want the vehicles assigned.
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Figure 16. Vehicle assignment window

¥ vehicle Department =10
r Department Assignment ———
=k Davis Motors

E1-[] Davis Chevrolet
- [] New
-] Used
-[] Service
-[] Rental
Davis Ford

Lancel | Hext |

Click Next.

A message displays, prompting you to choose how to handle imported vehicle records with VINs identical
to existing vehicle records in the KeyAdvantage database.

* Click Yes to have the imported vehicle information override the existing vehicle information for
identical records.

« Click No to have the existing vehicle information override imported vehicle information for identical
records.

7. Astatus bar displays the number of records imported.

Alog file generates automatically that displays the total number of vehicles successfully imported, as well as any
skipped records and the reason why they were not imported.

Assigning KeyTags to Vehicles

Once the vehicle information has been entered, assign a KeyTag to the vehicle record.
To assign a KeyTag to the vehicle, do the following:
1. Attach the vehicle keys to the KeyTag.

2. Click Vehicle Information > Modify Vehicle Information. The Modify Vehicle Information window
displays, as shown in Figure 17.
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Figure 17. Assign KeyTag

7.
8.
9.
Note:

KeyAdvantage--> Modify Vehicle Information—>[Supra] =101 %]
|ﬁD|IE/nH}(||(}:C:G{>G{)| Recard Count: 141 |
rVehicle Informati r Department Assi t

WM B Mational Auto Group

|1G1AP8?H4CN1DDDDS | = Courtesy Chevrolet

Stock Mumber ear % :ewd

se

2551 |2DD4 j [] General Sales

Make Model [] Service

|cHEwY =l JeniaLancHE | [] Body

Color Wehicle Status E| L__||S:| _I:lhe:la:j

mith For

[siveR =l JacTiE = [ New

Maied ] — [ Used

| E ----- [] General Sales

T — [ Service

R 1 I [] Body

| H ----- [] Rental

— KeyT ag Assi
Azsign KeyTag | Unassion KeyT ag |
KepTag Serial Mo: |

Find | iew Charge Histary LClose |

Click Search.

Enter or select the search criteria in any active field. You can use the asterisk (*) or the percent sign (%)
as wildcards when searching for a record.

Click Find.

If necessary, scroll through the records using the arrow buttons at the top of the screen to locate a
specific vehicle.

Click the Modify Current Record button.
Place and hold the KeyTag on the programming base.
Click Assign KeyTag. The KeyTag serial number is displayed.
You can assign more than one KeyTag to a vehicle if there are more than one set of vehicle keys.

Unassigning KeyTags from Vehicles

When a vehicle is sold or when a KeyTag is removed from a vehicle for another reason, you will need to unassign
the KeyTag from the vehicle. To unassign the KeyTag, do the following:

1.
2.

Click KeyTag > Unassign KeyTag.

Place and hold the KeyTag in the programming base. KeyAdvantage displays the vehicle to which the
KeyTag is assigned.

The status changes automatically to Sold. Select another status for the vehicle from the dropdown list if
the vehicle is not sold.

Place and hold the KeyTag in the programming base.

Click Unassign. The Unassign KeyTag window displays, as shown in Figure 18.
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Figure 18. Unassign KeyTag

ol xi
KeyTag Serial Ma:
000001611488

r—Wehicle Infarmation
WM
|1 G14PSFHACN 100008 |
Stock Mumber Vehicle statuz
2551 |s0LD =l
Year Make
|2uu4 | |EHEW |
todel Calor
[EMALANCHE | [pILvER |

Unassign | Hext | LCloze |
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Chapter 3. Using KeyPads and KeyBoxes

This chapter provides information on using KeyPads and KeyBoxes, including checking modules in and out, as
well as reading, modifying, and diagnosing the modules.

Checking Out KeyPads

To activate the KeyPad and program the key holder’s PIN code, access hours, and KeyBox access permissions,
you need to check out the KeyPad.

To check out a KeyPad, do the following:
1. Click KeyPad > Check Out. The KeyPad Check Out window displays, as shown in Figure 19.

Figure 19. KeyPad check out window

KeyPad Check Out ]

Lagin 1D
|KF'arker |

PIM

|xmm |

Check Qut I LCancel |

2. Enter your login ID and PIN code.
3. Click Check Out. The KeyPad Check Out window displays, as shown in Figure 20.

Figure 20. KeyPad check out confirmation

KeyPad Check Out X
Jzer Mame KeyPad Seral Mumber
Traci Flagmann | |?1 000145

4. Place the KeyPad upside down on the programming base.

5. Once the yellow IR light on the programming base is lit, press the green Start (=) button on the
KeyPad.

6. Click Close.

If you attempt to check out a KeyPad after you have exceeded the maximum number of KeyBox accesses, a
warning message will appear that reads:

The maximum number of KeyBox accesses has been reached.
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At this point:
« If you click Cancel, you will not be allowed to check out a KeyPad for that day.

» If you click the Manager Override button, your manager must enter his/her login ID and password and
click Authorize Override in order for you to check out a KeyPad.

Checking In KeyPads

When a key holder checks in a KeyPad at the end of a shift, the vehicle access activity in the KeyPad downloads
into the KeyAdvantage System.

To check in a KeyPad, do the following:
1. Click KeyPad > Check in. The KeyPad Check In window displays, as shown in Figure 21.

Figure 21. KeyPad check in confirmation

KeyPad Check In : x|

Uszer Mame KepPad Senal Mumber
Eill Jones | [71008840 |

b. Place the KeyPad upside down on the programming base.

c. Once the yellow IR light on the programming base is lit, press the green Start (¢=) button on the
KeyPad.

d. Click Next KeyPad to check in another KeyPad or Close if done checking in KeyPads.

Modifying KeyPads
To change the status of a KeyPad to Lost or Inactive so it can no longer be checked out, use the Modify KeyPads
menu option. To modify KeyPads, do the following:

1. Click KeyPad > Modify KeyPads. The Modify KeyPads window displays, as shown in Figure 22.

Figure 22. Modify KeyPads window

KeyAdvantage——:::-Modify KeyPads—- =[5 i =] 4
|5|fﬂ E||CJCJ-‘;>-‘;>I Record Count 243 |
—k.eyPad Informatiorr

Serial Mumber Agzigned User ld — Assigned User Name

[F1008s40 | [2 | [Bil Jones |

Status Battery Status Firmvuare ' ersion

| ctive | fox MEE

Mate 1

Mate 2

| |
Find |

2. Click Search.

3. Enter or select the search criteria in any active field. You can use the asterisk (*) or the percent sign (%)
as wildcards when searching for a record.
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Click Find.

If necessary, scroll through the records using the arrow buttons at the top of the screen to locate a
specific KeyPad.

Click the Modify Current Record button.

You can change the status and notes when modifying a KeyPad. Select the status from the dropdown list
and enter any applicable notes in the Notes fields.

There are three KeyPad statuses:
Active—The KeyPad can be checked out.
Inactive—The KeyPad can be checked in but cannot be checked out.

Lost—The KeyPad can be checked in but cannot be checked out.
Click Save.

Diagnosing KeyPads

The Diagnose KeyPads menu option displays the settings programmed into the KeyPad and provides information
that is helpful in diagnosing the KeyPad. To diagnose KeyPads, do the following:

1.
2.
3.

Click KeyPad > Diagnose KeyPads.
Place the KeyPad upside down on the programming base.

Once the yellow IR light on the programming base is lit, press the green Start (=) button on the
KeyPad.

The diagnostic information displays the following:

The General tab (Figure 23) displays information on the KeyPad and the key holder if the KeyPad is
currently assigned or checked out.

Figure 23. General tab

KeyAdvantage-->Diagnose KeyPads-->[Supra] o ] |
T KewBox Permission T Ermor Log T Access Log T K.eyBox Read T K.eyBox Back Fead ]
KeyPad Information : Programming Base Information :
KeyPad Serial Humber 7000212 Family Code 3
Family Code 3 Product Code a0
Product Code 20 Firmnwware Yersion o004
Firmnwsare Wersion 01
PIM Code i
M anufactuning Date 01./01./2000 12:00:00 Ak
KeuT ag Tracking ]3]
KeyPad Time 04/02/2004 10:48:45 AN
System Code Q0007777
Battery Status Lo
DayLight Saving Time ul3]
Last Error FE[F.ey Expired [The Key iz not checked o...
b ax No:Of KeyBox Access Allowed Unlimited
Uzer D 4
User Mame R Anderson
Pragramming D ate/Time 04/02/2004 09:52:31 AM
Purpoze Code OMAOFF 0r
Access Hours
Start DateTime 03:00:00 &b
End Date/Time 08:00:00 Pt
Check In/Check Out Check Out
Inventory Status Active Expart |
DO NOT REMOYE THE KEYPAD FROM PROGRAMMING BASE Clase |
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* The KeyBox Permission tab (Figure 24) shows the dealerships and departments the KeyPad can access.

Figure 24. KeyBox permission tab

KeyAdvantage-->Diagnose KeyPads-->[Supra] 3 =101 x|
General T T Errar Log T Access Log ]
— KeyBox Informati — rataB ase Inf
I Supra Auto Group - I Supra Auto Group
| - E Hational Auto Group [ E Hational Auto Group

] Courtesy Chevrolet
] Hew

- Used

-] General Sales
M Service

-] Body

] Courtesy Chevrolet

- ] Rental -] Rental
- Smith Ford -] Smith Ford
- W] Hew ] Hew

W Used

-] General Sales
-] Service

-] Body

-] Rental

DO NOT REMOVE THE KEYBOX FROM PROGRAMMING BASE Cloze |

* The Error Log tab (Figure 25) displays errors that have occurred in the KeyPad.

Figure 25. Error log tab

KeyAdvantage-->Diagnose KeyPads-->[Supra] b o ] 4|

General T KevBox Permission T T Access Log T keyBox Read T keyBox Back Fead ]
D ate | Count | Code | Description
0372672004 1 FG6 Key Expired [The Key iz not checked out]
0372572004 1 83 Ho auth cookie
037052004 1 F3 Clock iz not running

DO NOT REMOYE THE KEYPAD FROM PROGRAMMING BASE Clase |
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* The Access Log tab (Figure 26) shows the KeyBoxes accessed since you last checked out the KeyPad.

Figure 26. Access log tab

KeyAdvantage-->Diagnose KeyPads-->[Supra]

~=1ol |

General T KeypBox Permiszsion T Error Log

I

T KeyBox Bead

T KeyBox Back Read ]

| KeyBox Date/Time | User ID

KeyPad Date/Time | KeyBox | KeyTag | Yehicle ID | Purpose
0372572004 01:45.... 80007732 000001611488 -1 0-5ales Demo
0372572004 03:23:...  BDOO7732 000001611488 2 1-5Service

0372572004 01:43:... 3
0372572004 03:20:... 3

DO NOT REMOYE THE KEYPAD FROM PROGRAMMING BASE

LCloze |

* The KeyBox Read tab (Figure 27) displays information stored in the KeyPad from a key holder performing

a Read Box function.

Figure 27. KeyBox read tab

KeyAdvantage-->Diagnose KeyPads-->[Supra] =10 x|
General T KeyBox Permizsion T Eror Log T Access Log T T K.eyBox Back Read ]
| Accessed | Returned
Access No| KeyPad | UserlD | UserName [ Date/Time KeyTag |Vehicle ID | Purpose | KeyTag [Vehicle IO
1 f1o000212 2 T Plagmann 03/24/2004 03:59: 00000161146 0 FF 00000161148 D
2 F1000212 2 T Plagmann 03/24/2004 03:59: 00000161146 0 0-Sales Demo 00000161148 D
3 1000212 2 T Plagmann 03/25/2004 10:39: D0O0DD16114B 0 0-Sales Demo 0000016114 D
4 F1000212 4 R Anderson 03/25/2004 11:50: DO0DO16114B 0 0-Sales Demo 00000161148 -1
5 F1000212 3 J Fisher 03/25/2004 01:43: 00000161148 -1 0-Sales Demo 00000161148 2
6 71000212 3 J Fisher 03/25/2004 03:20: DOODO16114B 2 1-Service 00000161148 2

DO NOT REMOVE THE KEYPAD FROM PROGRAMMING BASE

LCloze |
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* The KeyBox Back Read tab (Figure 28) displays KeyBox access information stored in the KeyPad. Each
time a user accesses a KeyBox, the KeyPad stores the previous access in the KeyBox.

Figure 28. KeyBox back read tab

KeyAdvantage-->Diagnose KeyPads-->[Supra] 3 B =] ]
General T KevBox Permizsion T Ermor Log T Access Log T KeyBaox Read T
[ Accessed [ R etur
Type | KeyPad | UserIlD | UseiName | Date/Time | KeyTag | ¥ehicle ID | Purpose | KeyTag [Vehid
Lock Opening F1000212 4 R Anderson | 03/25/2004 11:50: DD00016114B 0 0-Sales Demo 00000161148 O
Lock Opening 1000212 3 J Fisher 03/25/2004 01:43: 00000161148 1 0-Sales Demo 00000161148 0
4 »
DO HOT REMDYE THE KEYPAD FROM PROGRAMMING BASE Clase |

Flashing KeyPads

If Supra releases a new version of KeyPad firmware, the KeyAdvantage software lets you import the new version
into your system and then “flash” the KeyPads to update the firmware.

Importing firmware
To import a new firmware file into your KeyAdvantage system, do the following:
1. Copy the .HEX firmware file from Supra to the KeyAdvantage computer.
Click File > Import.
Click Browse and navigate to the .HEX firmware file saved on the computer.
Highlight the .HEX file and click Open.
Click the Import button.
Click Close.

o ok w N

Flashing KeyPads
To flash KeyPads with the new firmware, do the following:
1. Click KeyPad > Flash KeyPads. The Flash KeyPads window displays, as shown in Figure 29.
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Figure 29. Flash KeyPads window

M xeyadvantage-->Flash KeyPad oy ] [
Target FevPad Firmware Detail

Firmware File Mame  |FAKey 0015 hex
Firrmare Werzsion

|£Iash K.eyPad i Close |

Place the KeyPad upside down on the programming base.
Click the Flash KeyPad button in the Flash KeyPads window of the software.
Press the green Start (=) button on the KeyPad.

o s~ Db

A successful status message displays when the flashing process is complete. Click OK.

Modifying KeyBoxes

The Modify KeyBox menu option allows you to view KeyBox details, generate an activity report for an individual
KeyBox, or change the KeyBox status and notes without using the programming base. You can search for a single
KeyBox by serial number, or search for all KeyBoxes by status, battery status, or department. Scroll through
multiple KeyBox records using the arrow buttons.

To view KeyBox details or modify a KeyBox, do the following:
1. Click KeyBox > Modify KeyBoxes. The Modify KeyBoxes window displays, as shown in Figure 30.

Figure 30. Modify KeyBoxes window

KeyAdvantage——:::-Mudify KeyBoxes—-=[Willamette Auto Group] = | Ellll
|ﬁ|!n HHCJ4:'1:|'>C:>I Fiecord Count 141 |
r K.ewBox Information r KeyBox Assignment

Serial Mumber Status Programmed D ate Battery Status =

(2] [scwe <] (V0] [ ]

Mote 1

Mote 2

rLockout List

Eind | Wiew Activity Record | N

Click Search.
Enter the KeyBox serial number and click Find. The KeyBox details display.

Click the View Activity Record button to view KeyBox activity.

Click the Modify Current Record button to modify the KeyBox.

Select the dropdown list under Status to change the KeyBox status to Active, Inactive, or Lost.
Change or add notes about the KeyBox in the Notes fields.

Click Save.

© N o g bk DN
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Programming KeyBoxes

To change the settings in a KeyBox, do the following:
1. Place the KeyBox in the programming base.
2. Click KeyBox > Program KeyBoxes. The Display KeyBoxes window displays, as shown in Figure 31.

Figure 31. Program KeyBoxes window

KeyAdvantage-->Program KeyBoxes-->[Supra] 3 =101 =1

r kepBaox Infarmation  kepBox Aszsignment
Serial Mumber Status Battery Status -

Supra Auto Group

80007732 IActlve | oK El-4/] National Auto Group

Mote 1 EIE Courtesy Chevrolet

| | - New
: Used

Note 2

r Lockout List

General Sales
Service

Body

Rental

Avalable KeyPads Lackout KeyPads Ell:‘ Smith Ford
=omz 1 Il - [ New
Ao I [ Used
E L0 N (R [ A I N [] General Sales
> I
----- [ Service
2 I ..... ] Body
« I ----- [] Rental
|

Program I Hest KepBox | Cancel | LCloze |

3. The current settings in the KeyBox display. You can change the following settings in a KeyBox:

Status of the KeyBox—There are two statuses for a KeyBox: Active and Inactive. Use Active for
KeyBoxes that are currently in use and Inactive for KeyBoxes that are not in use.

Notes—Add or edit KeyBox notes.

Lockout list—Add or change the KeyPads on the lockout list by selecting the KeyPad serial number and
clicking the appropriate arrow.

KeyBox assignment—You can change the dealerships or departments where the KeyBox is used if you
are logged in as a dealership administrator.

4. Click Program.

Reading KeyBoxes

The KeyBox Read menu option downloads and displays all of the vehicle access information stored in the
KeyBox. To access this information, do the following:

1. Place the KeyBox in the programming base.
2. Click KeyBox > KeyBox read. The KeyBox Read window displays, as shown in Figure 32.
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Figure 32. KeyBox read window

KeyAdvantage-->KeyBox Read-->[Supra] R =]
KeyBox Serial Mo Mumber of Accesses
[BO007732 | [E |
KeyBox Access Log
Accessed [ Returne|
Access No| KeyPad | UserID | Agent [ Date/Time [ KeyTag [Vehicle ID| _ Purpose | KeyTag [Ve
(71000212 2 T Plagmann 03/24/2004 03:59:00 0000016114B8 O 0-Sales Demo  0000016114B8 O
2 1000212 2 T Plagmann 03/24/2004 03:59:26 0000016114B8 O FF 0000016114B8 O
3 flooo212 (2 T Plagmann 0372542004 10:39:37. 0DDOO16114B8 O 0-S5ales Demo  0000016114B8 O
4 71000212 4 R Anderson 03/25/2004 11:50:11. 0DDDD16114B8 O 0-Sales Demo | 000DD16114B8 | -1
5 71000212 3 J Fisher 03/25/2004 01:43:19 0000016114B8 -1 0-Sales Demo 000000000000 O
4 3
DO NOT REMOVE THE KEYBDX FROM PROGRAMMING BASE Close |

3. Information about the 35 most recent KeyBox accesses displays. The user name, the date and time the
user removed the KeyTag, and the date and time the user replaced the KeyTag display.

Diagnosing KeyBoxes
The Diagnose KeyBoxes menu option displays the settings programmed into the KeyBox and provides
information that is helpful in diagnosing the KeyBox.
To diagnose a KeyBox, do the following:
1. Place the KeyBox in the programming base.
2. Click KeyBox > Diagnose KeyBoxes.
3. The diagnostic information displays the following:

* The General tab (Figure 33) displays general information on the KeyBox.
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Figure 33. General tab

KeyAdvantage-->Diagnose KeyBoxes—->[Supra] =11
Gy T KevBox Permizsion T Error Log T Access Log ]

KeyBox Information : Frog ing Base Info ki

Serial Humber 80007732 Family Code 3

Family Code 3 Product Code an

Product Code 0z Firmware Wersion 0004

Firmwsare ersion 1.0

Supstern Code 00007777

Manufacturing Date 03/05./2004 12:00:00 Ak

Key Container Access Count 4

Pragramming Date

KeyBox ATC Date/Time 03/25/2004 01:57:00 P

Lockout List [Empty]

E=port |

DO NOT REMOYE THE KEYBDX FROM PROGRAMMING BASE Cloze |

*  The KeyBox Permission tab (Figure 34) shows the dealerships and departments where you can place
the KeyBox.

Figure 34. KeyBox permission tab

8] KeyAdvantage—->Diagnose KeyPads-->[Supra] =10
General T T Errar Log T Access Log ]
— KeyBox Inf b — D ataB ase Ink 111
E Supra Auto Group - E Supra Auto Group
o — E National Auto Group | — /] Mational Auto Group

- jyf] Courtesy Chevrolet - bf] Courtesy Chevrolet

DO NOT REMOYE THE KEYBOX FROM PROGRAMMING BASE Close |




Chapter 3
Using KeyPads and KeyBoxes

* The Error Log tab (Figure 35) displays the recent errors in the KeyBox.

Figure 35. Error log tab

KeyAdvantage-->Diagnose KeyBoxes-->[Supra] o ] P3|
General KevBox Permission T Error Log T Access Log ]
D ate/Time | KeyPad Serial Number | Count | Code | Description -
0370372004 11:35:15 AM 71000335 1 7B Key Container Timeout
0370372004 11:33:41 AM 71000334 1 7B Keyp Container Timeout
03/03/72004 11:18:04 AM 71000335 2 7B Key Container Timeout
03/03/2004 08:55:04 AM 71000334 Ll 7B Keyp Container Timeout
03/02/72004 07:08:08 PM 71000335 1 78 Permissions do not match
i
< |
DO HOT REMOYE THE KEYBOX FROM PROGRAMMING BASE Clase |

* The Access Log tab (Figure 36) shows the KeyPad access information stored in the KeyBox.

Figure 36. Access log tab

KeyAdvantage—->Diagnose KeyBoxes—->[Supra] o ] B4
General KeyBox Permission T Eror Log T ]
Accessed Returned|
Access No| KeyPad | UserID | Agent [ Date/Time KeyTag [Wehicle ID|  Purpose | KeyTag [Vehi
1 71000212 2 T Plagmann 03/24/2004 03:59:00 0000016114B8 |0 0-5ales Demo | 0000016114B8 O
2 71000212 2 T Plagmann 03/24/2004 03:59:26 0000016114B8 |0 FF 0000016114B8 O
3 71000212 2 T Plagmann 03/25%/2004 10:39:37 . 0000016114B8 |0 0-5ales Demo | 0000016114B8 O
4 71000212 4 R Anderson 03/25%/2004 11:50:11 . 0000016114B8 |0 0-Sales Demo | 00D0016114B8 | -1
5 71000212 3 J Fisher 03/25/2004 01:43:19 0000016114B8 | -1 0-5ales Demo | 000000000000 | O

DO NOT REMOVE THE KEYBOX FROM PROGRAMMING BASE

LCloze |
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Chapter 4. Reports

This chapter provides information on generating reports, and scheduling reports for automatic
distribution.

To generate a report, do the following:
1. Click the Reports menu.
2. Select the type of report to generate. The Key Holder Report window displays, as shown in Figure 37.

Figure 37. Sample key holder report screen

KeyAdvantage-->KeyHolder Report-->[Supra] | = ] 3
[ECX/cb|SRd|F| |
— Repart Criternia
r Select by r Purpose Codes——————— ~KeyPad Access Date
[y Holder | ¥ Seleatal I selectal ﬁ 31004 x| ot [3/3172004 7]
0 Sales Demo -
E  ASmih O Service Access Duration
5 JBaker Oz Foi ’7|Larger than hd HH:MM ‘
3 JFisher Oz HightRemoval Sort By
8 K Paker
04 Body Shop IKe_l,l Holder Hams ~| ¥ Descending
4 A Anderson O5 siemarket
9 FRReed OE&  Ovemight Hizalzy
E7  THIl d IVIN ¥ | I Descending
2 T Plagmann then by
*| T Descending
I~ Schedule this report for email distibution “Wigw Error Lag |
*  Access reports summarize key holder, vehicle, demo activity, vehicle aging, or purpose summary
information.

+ KeyPad assignment reports display in-use or expired KeyPads or KeyPad assignment history.
* Reconciliation reports generate vehicle key removal or KeyTag reconciliation data.
* Inventory reports summarize KeyPad, KeyBox, and vehicle inventory information.
»  Configuration reports display system user configuration and key holder configuration data.
« History reports show all record changes made within a specific time period.
3. Set the report options.

Select the report destination by clicking the Print, Print Preview, or Export button, or schedule the report
for e-mail distribution by checking the Schedule This Report For E-mail Distribution box.

Scheduling Reports for Automatic Distribution

To schedule reports to be automatically generated and delivered to an e-mail address, do the following:
1. Select the Reports menu.
2. Select the report to schedule.
3. Check the Schedule This Report For E-mail Distribution box.
4. Click the New Schedule button. The Vehicle Report window displays, as shown in Figure 38.
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Figure 38. Vehicle access report scheduled for automatic distribution

© N o o

Keyndvantage——:::-\l'ehicle Report--=[Supra Auto Group] = IDIﬂ
EEEYE-IEEYAr |
—Fepoit Criteria

r Select by

X . X KeyPad Access Date:
- X [~ Display Vehicles with ho access
IDepartment Assignment ¥ | [ Select allinlist I a8/ 5 /2005 j thin I 8/5 /2005 j

Purpose Codes

EIE 1 Daviz Motors = ¥ Select allin list | —Sort B
BB 1 Davis Cheviolet 0 Sales Dema " Ih B Dseenilig
| 1 Service then by
- 2 PDI IMake 'l I Descending
3 MightRemaval -
B[] 2 Davig Ford - 4 Body Shep - IYeal 'l I Descending
— £ s Leck
¥ Schedule this report for emall distibution Wiew Ermor Log |
r Schedule Fiecipient
Diescription Format Jirn. B aker@supraauto. com
‘\N’eekly Wehicle Access repart | IStandard Repart j Michael Stevens@supraauto. com
Frequency Day/Date Time
[weekly =l [Fridsy =] [omooam = add.. | Bemove |
&l Schedules for this Report
it | Description | Frequency | Soit Option | Status

Set the report options.

Enter a description for the report.

Select the report format: Standard report (RTF format), Microsoft Excel, or Both.
Click Add in the Recipient box to add a recipient to the distribution list.

Enter a valid e-mail address and click OK.

To remove a recipient from the distribution list, do the following:

1.
2.

Highlight the e-mail address, click the Remove button, and click Yes to confirm.
Select the frequency from the dropdown list. The report can be distributed daily, weekly, or monthly.

Daily—Contains access activity for the previous day. (For example, a report run on May 20 would contain
data from May 19.)

Weekly—Contains access activity for the previous seven days. (For example, a report run on May 20
would contain data from May 13 through May 19.)

Monthly—Contains access activity for the previous month. (For example, a report run on May 20 would
contain data from April 20 through May 19.)

If you schedule the report to be delivered weekly or monthly, select the day or date from the dropdown list
that you want the report run and distributed.

Select the time for the report to be generated and distributed.
Click Save.

To view any errors from scheduled reports, click the View Error Log button.
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Chapter 5. Database Maintenance

This chapter provides information for backing up, archiving, unarchiving, and purging the information in your
KeyAdvantage database.

Backing Up KeyAdvantage Data

The KeyAdvantage software can back up the KeyAdvantage data files to either a local drive or a mapped network
drive. You can schedule the backup to run at a specific time each day or initiate it at any time.

To schedule an automatic backup, do the following:

1. Click Administrator > Backup Schedule. The Backup Schedule window displays, as shown in
Figure 39.

Figure 39. Backup schedule window
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Select the time for the automatic backup to occur each day.

Select the drive and folder to place the backup data.

Click Enable.

You will receive confirmation that you successfully backed up the schedule. Click OK.
6. Click Close.

To cancel a scheduled backup:

o k0D

1. Click Administrator > Backup Schedule.
2. Click Disable.
3. Click Yes to confirm disabling the scheduled backup.
4. Click Close.
To initiate a manual backup:
1. Click Administrator > Database Maintenance.
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Figure 40. Manual backup
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Click Backup Data.

Enter your KeyAdvantage login password.

Click OK.

Check whether to back up the entire database, the configuration data, or the configuration and user data.
Select the drive and folder to place the backup data.

Click Backup.

You can view a log showing the type of backup and the location when the backup completes.

© N o gk 0w

Archiving KeyAdvantage Data

The KeyAdvantage system can archive any vehicle access information stored in the database. For optimal
system performance, archive any data over two months old. The server stores archived data separately and does
not display it in activity reports. You can retrieve archived data any time using the Unarchive Data function.

To manually archive data at any time, do the following:
1. Click Administrator > Database Maintenance.
2. Click Archive Data.

Figure 41. Manual archive
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3. Enter your KeyAdvantage password.

Choose whether to archive data prior to a specific date or all data older than a specified number of
months, then enter the date or number of months.

5. Click Archive.
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6. Click Yes to confirm archiving the records prior to the specified time period. A successful status message
is displayed when the archive is complete.

To schedule automatic archiving, do the following:
1. Click Administrator > Database Maintenance.
2. Click Archive Data. The Archive Data window displays, as shown in Figure 42.

Figure 42. Archive data
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Enter your KeyAdvantage password.

Check the Automatic Scheduling box.

Specify, in months, how often the system should perform the automatic archive.
In the Archive Period section, specify the number of months of data to archive.
Click Archive.

8. Click Yes to confirm archiving the records prior to the specified time period.

N o o bk~ w

To discontinue automatic archiving, follow steps 1 to 3 above, then deselect the Automatic Scheduling box and
click Close.

Unarchiving KeyAdvantage Data

Use the Unarchive Data function to unarchive any data that has been archived in the KeyAdvantage system. You
can unarchive data from the last six months or by a specific date.

To unarchive data, do the following:
1. Click Administrator > Database Maintenance.
2. Click Unarchive Data.
3. Enter your KeyAdvantage password.
4

Choose whether to unarchive all data less than six months old or to unarchive data from a specific date,
as shown in Figure 43.
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Figure 43. Less than six months old
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5. Click Unarchive.

6. Click Yes to confirm unarchiving the records. A successful status message displays when the unarchive
function is complete.

Purging Vehicle Inventory Data

The KeyAdvantage software allows you to purge sold vehicle records. To maintain optimal system performance,
purge your sold vehicle inventory on a regular basis. Purged vehicle records are permanently deleted and will not
display in activity reports. Back up your system data before performing a purge.

C CAUTION: Purged vehicle records are permanently deleted and will not display in activity reports. Back up
your system data before performing a purge..

To purge sold vehicle records, do the following:
1. Click Administrator > Database Maintenance.
2. Click Purge Data.
3. Enter your KeyAdvantage password.
4

Choose whether to purge data prior to a specific date or all data older than a specific number of months,
then enter the date or number of months, as shown in Figure 46.

Figure 46. Specific number of months
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Click Purge.

6. The KeyAdvantage software asks if you'd like to create a backup file. Choose Yes or No. If you choose to
create a backup file, do the following:

a. Select the backup option: Entire Database, Configuration Data, or Configuration and User Information
Data.

b. Select the drive and folder to place the backup data.
c. Click Backup.
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Click Yes to confirm the backup.
The KeyAdvantage software asks if you want to view the log file for the backup. Click Yes or No.

- o a

The Purge data window displays. Click Purge.

g. When asked if you want to backup data, click No.
Click Yes to confirm the purge.

Click Close.

Restoring the Entire Database

The KeyAdvantage software allows you to restore the database from a backup file. You must perform the
database restore function on the KeyAdvantage server with only one user logged in. Save the backup file on a
local drive on the server computer instead of a mapped network drive.

To restore the entire database, do the following:

1.

2R o

Click Administrator > Database Maintenance.

Click Restore Data.

Enter your KeyAdvantage password.

Click Browse to locate the backup file on your computer, then click Open.
Click Restore.

The KeyAdvantage software asks if you'd like to create a backup file. Choose Yes or No. If you choose to
create a backup file:

a. Select the backup option: Entire Database, Configuration Data, or Configuration and User Information
Data.

Select the drive and folder to place the backup data.

Click Backup.

Click Yes to confirm the backup.

The KeyAdvantage software asks if you want to view the log file for the backup. Click Yes or No.

~ 0 ao o

The Restore Data window displays, as shown in Figure 47.

Figure 47. Restore data window
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g. Click Restore.
h. Click No when asked if you want to create a backup file.
Click OK to confirm the restore process.

When the restore process finishes, a log file generates and the KeyAdvantage software prompts you to
log in again to the KeyAdvantage system. Click OK.

64
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Appendix A. Troubleshooting

This section provides information to help you diagnose and solve various problems that may arise while
configuring or using your Supra product and offers technical support contacts in case you need assistance. See
“Contacting Us” on page 71 for details on how to contact Supra.

Device Programming Errors

Programming base errors are generally connection issues. To resolve:
* Reseat KeyBox, KeyPad or KeyTag on programming base.
»  Check connections between programming base and computer.
*  Check power connections.
e Turn the power to the programming base off and back on.

» Close all programming screens in the KeyAdvantage software, log out and close the KeyAdvantage
software, restart the application and log back in again.

»  Check to make sure all inventory has been imported into the system software.

Device Diagnostics

KeyAdvantage software provides a function that allows KeyBox and KeyPad configuration and error information to
be read using the programming base.

See “Diagnosing KeyBoxes” on page 55 and “Diagnosing KeyPads” on page 49 for details on diagnosing
KeyBoxes and KeyPads.

KeyBox-KeyPad Connection Errors

Most KeyBox errors occur when accessed by a KeyPad.

KeyBox-KeyPad errors can be connection or access issues. See “KeyPad Error Messages” on page 69 for details
on KeyPad errors. To resolve many connection issues:

* Reenter the PIN code and try again
» Shield the IR path from direct light and try again.

Access issues arise when KeyPads attempt to access KeyBoxes to which the key holder does not have access
privileges. These errors can be when:

« KeyPad serial number is on the KeyBoxes lockout list

» User attempts to access KeyBox outside of their shift as defined in the system software and programmed
into the KeyPad

+ KeyBox belongs to a department to which the key holder does not have access privileges
Many other access errors are user-related. These occur when:

*  Wrong PIN code is entered

* KeyPad is not updated

» User entered too many incorrect codes and is locked out for 10 minutes.

* User does not completely push up on the key container when attempting to access the KeyBox

+ KeyTag is not properly seated in the key container, not allowing the key container to close
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KeyAdvantage Software Error Messages

Table 1 lists some of the most common KeyAdvantage software error messages and their causes.

Table 1. KeyAdvantage Software Error Messages

Error message Logged Emailed Type Possible cause
Unable to connect to the Yes No Message box |+ KeyAdvantage database server is down.
KeyAdvantage database at - KeyAdvantage database server is
<ip_address>. unreachable.

 Authentication failure causes an error

while logging on to the database.

Error connecting to Yes Yes Log file » KeyAdvantage database server is down.
database while frying to « KeyAdvantage database server is
import records. unreachable.

+ Authentication failure causes an error

while logging on to the database.

Service failed to start. Yes No Message box | Internal unexpected error in the service.
Please review log file for Call customer support.
details.
Service failed to stop. Yes No Message box | Internal unexpected error in the service.
Please review log file for Call customer support.
details.
Service communication Yes No Message box | An error in the application GUI. Attempt
error. Please see log file for to restart the application. If the problem
details. persists, contact customer support.
Internal error. Please Yes Yes Message box | Internal application failure.
contact customer support.
The file provided does not | Yes No Message box | Attempting to import a file not exported by
include a valid profile. the tool, or a file that is corrupt.
The service shut down Yes Yes Log file/ Internal error in the service.
unexpectedly. message box
Invalid DMS inventory file. | Yes No Log file The DMS exported file is corrupt.
Unable to add task. Please | No No Message box | Cannot map directly to a network drive.

verify that the file path
specified is accessible by
the KeyAdvantage DMS
system service.

You must enter the entire file path.

KeyPad Troubleshooting

The KeyPad becomes inoperable if the KeyPad is removed from the programming base before being properly
disconnected. To fix a KeyPad that has become inoperable because of this, reprogram the KeyPad using the

programming base.

Table 2 shows the error messages and their associated codes that appear on the KeyPad. Error codes are
composed of two elements. The first two digits define the error, the last two digits show the number of times that
the error has occurred. For example, error code 2102 would mean that the error A7 has occurred twice.
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KeyPad Error Messages

Table 2 lists some of the most common KeyPad error messages and their causes.

Table 2. KeyPad Error Messages

KeyPad error message Error code Resolution
Box Battery Low 3Fxx Replace KeyBox
Clock Error Reprogram Key F1xx, F3xx Place KeyPad on programming base and check

in or out

Communication Error

01xx, 02xx, 03xx

Shield IR ports from light and try again

Incorrect Pin E7xx Reenter PIN code

Incorrect Update Code 2Dxx Reprogram KeyPad and/or KeyBox

Incorrect Update Code 3Dxx Reenter update code

Key Battery Low 35xx Change KeyPad batteries

Keypad Expired Check Out Key F6xx, 27xx Place KeyPad on programming base and check
in or out

No Box Found F4xx Realign the KeyPad with the IR port on the
KeyBox

No KeyBox Reads In Memory F2xx Read a KeyBox

Not Authorized

26xX, 28xX, 2AXX,
42xx, 43xXx, 76xX,
78xx, 79xx, E8xx,
ECxx, 7Fxx

Place KeyPad on programming base and check
in or out

Not Authorized 4Axx, 46xx, TEXx Reprogram KeyPad and/or KeyBox

Not Authorized 7Dxx Reenter update code

Not Authorized F5xx Maximum number of KeyBox accesses reached.
Place on programming base and reprogram with
increased number of accesses allowed

Not Authorized 49xx Remove the KeyPad serial number from the
KeyBox lockout list

Not Authorized 41xX, T4xX, T5xX Wait 15 minutes and try again

Not Authorized 6Cxx, 7Cxx, 80xx Replace KeyBox

Not Authorized 71xx, 7Bxx Reenter PIN code and try again

Not Authorized 7AXX Open KeyBox during valid access hours

Not Authorized 29xx, 2Bxx, 2Cxx, Contact Supra Support

44xx, 45xx, 6AXX,
6Bxx

Program Error Reprogram Key FOxx Place KeyPad on programming base and check
in or out
Security Lockout Key Disabled EExx Place KeyPad on programming base and check

in or out

Unsuccessful

E9xx, EAxx, EBxx,
Edxx, EFxx

Place KeyPad on programming base and check
in or out
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Appendix B. Contacting Us

For help installing, operating, maintaining, and troubleshooting this product, refer to this document and any other

documentation provided. If you still have questions, contact us 5 a.m. to 7 p.m., seven days a week (excluding
holidays).

Website http://www.keyadvantage.com
E-mail suprasupport@fs.utc.com
Telephone 866.259.8077

Visit the www.keyadvantage.com website to view KeyAdvantage documentation and download the current software.


http://www.keyadvantage.com
mailto:suprasupport%40fs.utc.com?subject=Technical%20Support%20-%20KeyAdvantage
http://http://www.suprasystems.com/Products/Pages/KeyAdvantage.aspx
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